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Chapter 1: What's new

New features summary
The 2014 release of Edge Animate CC includes several new features and enhancements to help you create rich 
animations faster and easier. Read on for a quick introduction to new features and links to resources offering more 
information.

Support for native HTML5 video
Edge Animate provides an intuitive user interface to let you import HTML5 videos into your compositions.

The video then can be used as part of an overlay and can have other composition elements animate around the video. 
Also, since the format for the video is native HTML5, it plays on iOS and Android devices as well as in modern desktop 
browsers.

For more information on using video in your animations, see Add video to animations.

Sprite sheet import
With Edge Animate CC 2014, you can import sprite sheets to add advanced, multi-frame animations to your Edge 
Animate compositions.

Sprite sheets let your graphics download faster with fewer HTTP requests. Automatic keyframing of sprites on import 
saves time by reducing effort spent with manual positioning of frames.

You can import sprite sheets (File > Import Spritesheet) generated in Adobe Flash Professional CC 2014 or any other 
tool that lets you generate sprite sheets.
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Import sprite sheets

For more information on importing sprite sheets into Edge Animate, see Import sprite sheets .

Article linking for Adobe DPS
Edge Animate lets you link to your Adobe InDesign or DPS Folio articles using the options on the user interface 
without writing code. You can create interactive title pages, table of contents, and advanced navigation to target articles 
and article subsections of your digital publications more easily and quickly.

For more information on linking elements to eBook articles, see Hyperlink elements to eBook articles .

Enhanced Actions editor
The Actions pop-up window has been redesigned to be more designer-friendly. The enhanced Actions editor reduces 
the need to code, making it easier to add interactivity and more approachable for designers.

http://helpx.adobe.com/en/edge-animate/using/import-sprite-sheets.html
http://helpx.adobe.com/en/edge-animate/using/hyperlink-elements-dps-articles.html
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Actions pop-up window prior to Edge Animate CC 2014

Actions editor in Edge Animate CC 2014
A Step 1: Pick an action  B Step 2: Pick a target  C Step 3: Edit the code snippet  

The new Actions editor visually guides you through the various steps in assigning actions to targets.

1 Pick an Action - Actions are now logically grouped into categories. If you know the name of the action, you can 
search for the action using the search box. Else, pick a category to view the actions in it and click the required action.

2 Pick a Target - Targets are grouped under Stage. Click Stage to view the target elements. When you click Stage, you 
may find a subcategory for Symbols if your composition contains symbols. Double-click the target element.

3 Modify the code snippet as required.
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If you find portions of code that are reused often, you can save them as snippets and insert them with a single click 
when required.

Save code snippets
In the Actions editor, click '+' adjacent to My Snippets, and then click one of the following options:

Custom snippets

Create Custom Click to enter your own code and save it as a snippet. When you click this options, a code window 
appears. Type your code, click Save, and then enter a name for the snippet.

Add New From Selection Click to save the selected portion of the code as a snippet. Enter a name for the snippet in the 
Actions editor.

Insert code snippets
In the code window of the Actions editor, click at the location where you want to insert the code snippet. Click My 
Snippets, and then choose the required snippet from the list that appears. The saved snippet gets inserted at the 
insertion point in the code window. 

Copy-paste from Adobe Illustrator
With Edge Animate CC 2014, you can copy (Ctrl/Cmd+C) an illustration in Adobe Illustrator, and paste it 
(Ctrl/Cmd+V) directly into Edge Animate. No need to save the illustration as an SVG file in Adobe Illustrator and 
import it through the File > Import option as in the previous versions of Edge Animate. When you paste the illustration 
in Edge Animate, it is automatically imported as an SVG file.
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Adobe Illustrator illustrations imported as SVG files

Scrolling hand and zoom tools
Edge Animate CC 2014 includes scrolling hand and zooming tools to help you navigate your Edge Animate 
composition easily.

Zoom and pan tools
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Chapter 2: Download sample files

Download samples from Adobe
Download samples from Adobe

Sample Downloads from Chris Gannon's site
Sample Downloads from Chris Gannon's site

http://html.adobe.com/edge/animate/showcase.html
http://chrisgannon.wordpress.com/
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Chapter 3: Creating content & importing 
assets

Creating content for animation
Creating content for animation

Creating a project and importing content (Video)
Creating a project and importing content (Video)

Create assets and import them into your Edge Animate 
project
Create assets and import them into your Edge Animate project

Use web fonts
You can apply Edge Web Fonts to text directly from within Edge Animate. When you select a font from the Edge Web 
Fonts dialog, the corresponding code to fetch the font from the server is automatically incorporated into the code.

Edge Animate also allows you to specify fallback fonts when there is a problem with downloading, or using Edge Web 
Fonts on the user's computer.

1 Insert text within the Edge Animate canvas.

2 In the Text option of the Properties panel, click the "+" button next to the font menu.

http://tv.adobe.com/watch/learn-edge-animate/creating-content-for-animate/
http://tv.adobe.com/watch/learn-edge-animate/adobe-edge-animate-creating-and-importing-1-of-4/
http://adobe.ly/1bX4ASO
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3 Select the font that you want to use. A preview of the text with the applied font is displayed.

You can filter the fonts in the panel by their type using the buttons to the left of the panel. For example, to view only 
fonts of the sans serif type, click the Sans Serif button. 

4 Click Add Font.

The selected and applied fonts are added to the Font library in Edge Animate. Double-click the font in the Font 
library to specify fallback fonts. 

In cases where there is a problem with downloading web fonts from the server, the fallback fonts are used for display. 
The fonts are chosen in the order in which they appear in the list.
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Add audio to animations
Adobe Edge Animate now supports native HTML5 audio with the <audio> element — making it possible to add sounds 
to your animation projects. Using basic HTML and JavaScript, you can control audio playback in compositions. You 
can also bind audio elements to touch and mouse events, as well as trigger audio playback on the timeline. The audio 
capabilities in Adobe Edge Animate are embedded in the HTML DOM. So sounds play on any computer or device 
without requiring a plug-in.

You can import the following audio types into Edge Animate:

• .mp3

• .ogg/.oga

• .wav

• .m4a

• .aac

For the best cross-browser consistency, include .mp3 and .ogg resources of audio elements in your project. For a 
detailed description of supported audio types, visit Media formats supported by the HTML audio and video elements.

To create fallback versions of your audio file, you can use an audio conversion application such as Adobe Audition, 
which is included in your Creative Cloud membership. 

Add audio to compositions
Do one of the following:

• Drag-and-drop the audio files into your project from your file system. An 'audio group' with the name of the audio 
file is created in the Library. This audio group contains the audio file and the fallback files for cross-browser 
compatibility.

Note: Fallback files get automatically grouped under the audio group when you drop them into the project.

https://developer.mozilla.org/en-US/docs/HTML/Supported_media_formats
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Audio group in Library

• Click Add Audio in your project Library and browse for the audio file. Then, drag the audio group to the stage. 

Add Audio option in Library

After you add audio to your project, an 'audio element' appears in the Elements panel. When you select the audio 
element in the Elements panel, options to control the playback of your audio appear.

Audio in Elements panel

Play back and control audio
You can play back and control audio using any of the following options:

• Properties panel

• AutoPlay: Allows the audio file to automatically play on the timeline.

• Loop: Makes the audio file loop from the beginning after it finishes playing.

Audio control options in the Properties panel

• Timeline

• Play: Plays the audio file from the current playhead position.
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• Play From: Allows you to specify the time marker you want to play from.

• Pause: Allows you to pause the audio track. Use a play function to resume play back.

Audio control options in Timeline

• Audio actions: Using code snippets in Actions to control audio playback through events.

More Help topics 
Using audio on devices

Audio actions
1 Click {} adjacent to the audio element on the timeline to open the Actions editor.

2 From the list of events that appear, click the required trigger.

3 In the Pick An Action list, click Audio, and then click the required action.

Audio actions in Actions editor

4 In the Pick A Target section, click Stage, and then double-click the element to which the action that you selected 
must apply. 

5 If required, modify the code in the code window.

http://helpx.adobe.com/en/edge-animate/using/add-audio-animations.html#main-pars_header_3
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Important: Sometimes your audio plays perfectly fine locally, but fails to play after you load it to your Web server. In 
such cases, configure the .htaccess file of your Website to include the MIME types required for audio support. Contact 
your Website administrator for assistance.

Fine-tune audio
You can set keyframe transitions to control volume transitions in the timeline. Use volume transitions to create unique 
audio effects, such as, fade in, fade out, and cross-fading multiple tracks. 

Note: Volume transitions for audio are not available on most mobile devices. See Using audio on devices for restrictions.

Preload audio
To preload audio files before the composition loads, select “Preload Audio” in the Preloading section of the Properties 
panel on stage.

Note: Preloading audio is not available on most mobile devices. See Using audio on devices for restrictions. 

Enable the default audio player
You can use the browser default Windows Media Player to show controls for your audio. The default audio player is 
hidden by default. To turn the display of the player on, select the audio element and select “On” in the Properties panel. 

Enabling the default audio player

The player skin is rendered by the browsers, and appears different based on the browser it is viewed in. For example, 
the player you see in Chrome is different than the player you see in Firefox. See Audio actions to learn how to create 
custom controls that you can use to create your own player. 

When the player is viewed on stage, you can add motion and transform properties to the player like you add for other 
objects. Since <audio> elements are a special type of HTML element, only a subset of properties is available for you to 
apply:

• Opacity

• Clipping

• Position and Size

• Transform

Using audio on devices

iOS
In Safari on iOS (for all devices, including iPad), where users may be on a cellular network and be charged per data unit, 
preload, AutoPlay, and play back actions are disabled. No data is loaded until the user plays the audio.

http://helpx.adobe.com/en/edge-animate/using/add-audio-animations.html#main-pars_header_3
http://helpx.adobe.com/en/edge-animate/using/add-audio-animations.html#main-pars_header_3
http://helpx.adobe.com/en/edge-animate/using/add-audio-animations.html#main-pars_header_2
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You can use the Audio Actions to call an audio element triggered by a user event. For more information on audio 
actions, see Audio Actions .

Volume keyframes and control configured through the volume property are not supported on iOS devices. Users can 
adjust the volume using the volume control of the device itself.

Prior to iOS 4.0, iPhone and iPod touch did not play audio inline. Audio was presented in full-screen mode. Audio plays 
inline on iOS 4.0 and later on all devices. 

Android
Android generally has the same audio element limitations as iOS.

Tips and cross-browser considerations

Audio sync
Audio can be used to choreograph sound to your stage compositions. However, due to the nature of the Web, audio 
tracks can fall out-of-sync with elements moving on the stage. You may experience playback latency when coordinating 
movement with sound, especially in longer tracks. 

Audio Sprites
Using audio sprites allows you to create a single audio file with separate playable parts. This technique is used to 
download all your audio in a single file to save download time. 

To use an audio sprite, convert your audio element to a symbol and use play back markers to call the sections of your 
sprite. 

Add video to animations
Edge Animate supports native HTML5 videos making it easier for you to use your favorite video clips within your 
compositions. You can control the playback of videos using basic playback actions and JavaScript. Also, you can bind 
video elements to touch and mouse events to create a rich interactive experience. 

Video playback capabilities are supported in the HTML DOM. This means, the videos can play on any modern desktop 
or device browser without requiring a plug-in.

 

You can import .mp4 and .ogv files into Edge Animate.

For the best cross-browser compatibility, include .mp4 and .ogv resources of video elements in your project. For a 
detailed description of supported video types, visit Media formats supported by the HTML audio and video elements.

Add video to compositions
Do one of the following:

• Click File > Import or drag-and-drop the video files directly onto the Stage from your file system. A 'video group' 
with the name of the video file is created in the Library. This video group contains the video file and any fallback 
files you add for cross-browser compatibility.

http://helpx.adobe.com/en/edge-animate/using/add-audio-animations.html#main-pars_header_2
https://developer.mozilla.org/en-US/docs/HTML/Supported_media_formats
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Note: Fallback files get automatically grouped under the video group by name when you import them into the 
composition.

• Click Add Video in your project Library and browse for the video file. Then, drag the video group from the library 
to the Stage. 

Add Video option in Library

After you add a video to your composition, a 'video element' appears in the Elements panel. Options to control the 
playback of your video appear in the Properties panel when you select the video element in the Elements panel.

Playback and control video
You can play back and control video using any of the following options:

• Properties panel

• Autoplay: Allows the video file to automatically play on the timeline and desktop browsers.

• Loop: Makes the video file loop from the beginning after it finishes playing.

Video controls in Properties panel

• Timeline

• Play: Plays the video file from the current playhead position.

• Play From: Allows you to specify the time marker you want to play the video from.

• Pause: Allows you to pause the video. Use a play function to resume playback.
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Video playback options in Timeline

• Video actions: Using code snippets in the Actions editor to control video playback through events.

Video actions
1 Open the Actions editor by clicking {} adjacent to Stage on the Timeline.

2 Click a trigger (event).

3 From the Pick An Action list, click Video, and then click the required action.

You can also search for an action using the search box in the Pick An Action section.

Video actions in Actions editor

4 From the Pick A Target section, click Stage, and then double-click the element or symbol to which you want to assign 
the selected action.

You can also search for the element or symbol using the search box in the Pick A Target section.

Preload video
To preload video files before the composition loads, select “Preload Video” in the Preloading section of the Properties 
panel on stage.

Note: Preloading video is not available on most mobile devices. See Using video on devices for restrictions. 

http://helpx.adobe.com/en/edge-animate/using/add-html5-video-animations.html#main-pars_header_4
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Preload video

Enable the default video player
You can use the browser's default media player to show controls for your video. The default video player is hidden by 
default. To enable the default player, select the video element and select "Controls" in the Video section of the Properties 
panel. 

Enabling default video player in Properties panel

The player skin is rendered by the browsers, and appears different based on the browser it is viewed in. For example, 
the player you see in Chrome is different than the player you see in Firefox.

When the player is viewed on stage, you can add motion, transform, and other properties to the player like you add for 
other objects.

Using video on devices

iOS
In Safari on iOS (for all devices, including iPad), where users may be on a cellular network and be charged per data unit, 
preload, Autoplay, and playback actions are disabled. No data is loaded until the user plays the video.

You can use the video actions to call a video element triggered by a user event. For more information on video actions, 
see Video actions .

Android
Android generally has the same limitations for videos as iOS.

http://helpx.adobe.com/en/edge-animate/using/add-html5-video-animations.html#main-pars_header_6
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Import sprite sheets
As designers, you most likely use many other tools or programs such as Adobe Photoshop or Adobe Flash Professional 
to create complex images and character animations. Edge Animate lets you reuse such creations by supporting the 
import of sprite sheets generated from such tools.

A sprite sheet is an image file that contains several smaller graphics in a tiled grid arrangement. By compiling several 
graphics into a single file, you enable Edge Animate and other applications to use the graphics while only needing to 
load a single file. This loading efficiency can be very helpful in situations such as building animations where 
performance is especially important. 

Most tools let you export sprite sheets only as image files (PNG/JPEG). Adobe Flash Professional CC 2014 and later can 
generate Edge Animate-specific sprite sheets. You can import both types of sprite sheets - PNG/JPEG as well as the ones 
that are generated from Flash Professional - into Edge Animate.

 

Note: You may see performance issues with Edge Animate compositions on devices if you import and use sprite sheets of 
size greater than 2048 X 2048 pixels.

Import sprite sheets saved as only image files
1 Before importing sprite sheets into Edge Animate, ensure that:

• The images in the sprite sheet are of equal dimensions

• The padding between the images are uniform

2 Open Edge Animate. In the Symbols panel, right-click +, and click Import Sprite Sheets.

You can also click File > Import Sprite Sheets.

Import Sprite Sheets from Symbols panel

3 Browse for the required sprite sheet and select the PNG or the JPEG file. Click OK.

The Define Sprite Tiles dialog box appears. 



18
Creating content & importing assets

Last updated 6/15/2014

Define Sprite Tiles - importing PNG or JPEG sprite sheets

• To preview the animation, click Preview Animation

• Specify the duration and fps. For PNG and JPEG files, the fps is set to 24 by default. You can modify the fps as 
required.

• Specify the number of rows and columns and the trimming options.

4 Click Import.

The PNG or the JPEG file corresponding to the sprite sheet is saved in the Images panel. The constituent images are 
saved as separate symbols (named spritesheet_name_n) in the Symbols panel.

5 Drag the required symbols from the Symbols panel onto the Stage.

Import sprite sheets generated from Adobe Flash Professional
1 Ensure that you have generated the sprite sheet by choosing the Edge Animate format in Adobe Flash Professional 

CC 2014 (or later).

For information on generating sprite sheets in Adobe Flash Professional CC, see Adobe Flash Professional CC Help.

2 In the Symbols panel, right-click +, and click Import Sprite Sheets. 

http://helpx.adobe.com/flash/topics.html
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You can also click File > Import Sprite Sheets.

Import Sprite Sheets using Symbols panel

3 Browse for the required sprite sheet and select the PNG or the JPEG file. Click OK.

The Define Sprite Tiles dialog box appears. 

Define Sprite Tiles - importing Flash sprite sheets

• To load the EAS file that corresponds to the selected PNG or JPEG, select Load An EAS File.

• To preview the animation, click Preview Animation.



20
Creating content & importing assets

Last updated 6/15/2014

• Specify the duration and fps. For EAS files, the fps is inherited from the source. You can modify the fps as 
required.

4 Click Import.

The PNG or the JPEG file corresponding to the sprite sheet is saved in the Images panel. The constituent images are 
saved as separate symbols (named spritesheet_name_n) in the Symbols panel.

5 Drag the required symbols from the Symbols panel onto the Stage.

Hyperlink elements to Adobe DPS articles
e-magazines published through Adobe Digital Publishing Suite (DPS) can be made more engaging and interesting by 
including Edge Animate compositions in them. Edge Animate lets you publish the compositions as OAM files that can 
be easily included in Adobe InDesign (part of DPS).

In addition, Edge Animate compositions can be used as navigation aids within an e-magazine. Elements in a 
composition can be hyperlinked to specific articles in the magazine where the animation will be embedded. Readers 
can click these hyperlinked elements to quickly jump to the relevant article.

You can set up hyperlinking between the elements of a composition and the required Adobe DPS articles right from 
within Edge Animate. You can then test the linking by publishing the animation as OAM files and embedding them 
within the articles. 

To hyperlink elements to articles or pages in an Adobe DPS article:

1 Click {} adjacent to Stage on Timeline.

2 Select a trigger from the list that appears in the Actions editor. It is recommended that you choose the 
compositionReady event for setting up navigation.

Actions editor showing the compositionReady event



21
Creating content & importing assets

Last updated 6/15/2014

3 In the Pick An Action section, click Adobe DPS, and then click Navigate Article. Specify the Article Name and Page 
No you want to link to. You can also edit the code to specify these details as explained in Step 5.

Adobe DPS action options in Actions editor

4 In the Pick A Target section, click stage, and then double-click the name of the element that is the target for the 
action above.

5 (Optional) Edit the code to specify one of the following:

• The name of the article in the required Folio in Adobe InDesign and the page number

Example:

sym.$("Rectangle").append('<a style="display:block;width:100%;height:100%;" 
href="navto://my_article_Name#my_page_number"/>');

• Relative link to articles, such as first, last, next, previous, or current

Example:

To navigate to the last page of the last article in the folio, use navto://relative/last#last 

sym.$("Rectangle").append('<a style="display:block;width:100%;height:100%;" 
href="navto://relative/last#last');

For more information on using relative navto hyperlinks, see the Adobe DPS documentation.

Using Flash sprite sheets with Animate (Tutorial)
Using Flash sprite sheets with Animate (Tutorial)

http://helpx.adobe.com/digital-publishing-suite/help/hyperlink-overlays.html#relative_navto_links
http://layersmagazine.com/spritesheets-in-adobe-edge-animate.html
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Chapter 4: Create animations using the 
Timeline

The Edge Animate timeline
The Edge Animate timeline

Creating Animations in Edge Animate (Video)
Creating Animations in Edge Animate (Video)

Using the Pin tool, Keyframes, and Transitions for 
animation
You can create animations in Edge Animate using traditional animation methods based on keyframes. Edge Animate 
also provides an alternate method based on the Pin tool to create keyframes.

Create animations with the Pin tool
The Pin tool pins the property values of elements at a point in time on the Timeline. When you make an edit, the Pin 
tool pins the current value while you change the properties values at the Playhead. Edge Animate generates the 
keyframes and the transitions to or from the Playhead.

To animate with the Pin tool: 

1 Define element properties that you want to pin at a point in time on the Timeline.

2 Click the Toggle Pin button in the Timeline panel.

Toggle Pin

You can also activate the Pin by double-clicking the Playhead or pressing P on your keyboard. 

3 Drag the Pin on the Timeline to the location on the Timeline where you want to pin the element properties.

http://tv.adobe.com/watch/learn-edge-animate/the-animate-timeline/
http://tv.adobe.com/watch/learn-edge-animate/adobe-edge-animate-creating-animation-2-of-4/
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4 With the initial properties pinned, change the values of the element properties.

Because the chevron pattern points to the Playhead, the changes are set at the Playhead location.

Adobe Edge Animate automatically adds keyframes and transitions between the Playhead and Pin positions. You 
don't have to manually add keyframes or reposition the Playhead on the Timeline. 

5 Preview the animation by clicking the Play button in the Timeline panel or by pressing the Spacebar on the 
keyboard.

For a lesson on animating with the Pin tool:

1 Select Window > Lessons in Edge Animate.

2 Click Animate II: The Pin.

Keyframes specify the value of a property at a point in time. When animating with keyframes, you add a keyframe at 
two or more locations on the Timeline and define different element properties at each location. Edge Animate uses the 
property values to animate the content between the keyframes.

To animate with keyframes:

1 Select the element you want to animate on the Stage.

2 Move the Playhead to the location on the Timeline where you want the animation to start.

3 In the Properties panel for the element, click the Add Keyframe button (diamond button) next to the property that 
you want to change over time.

Adding a keyframe

4 Move the Playhead to another location on the Timeline and change the value of the property. 

Edge automatically adds an ending keyframe and creates the transition.

5 Preview the animation by clicking the Play button in the Timeline panel or by pressing the Spacebar on the 
keyboard.

For a lesson on animating with keyframes:

1 Select Window > Lessons in Edge Animate.

2 Click Animate I: Keyframes.

Edit individual keyframes
1 Move the Playhead to a keyframe (diamond icon) on the Timeline.

2 Change the editable property value on the left side of the Timeline panel.

Copy transitions
You can copy a transition and paste it on the Timeline of the same element or of another element.

1 Click a transition on the Timeline to select it. When selected, an orange border appears around the transition bar on 
the Timeline.
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2 Press Ctrl+C (Windows) or Cmd+C (Macintosh) to copy the transition to the Clipboard.

You can also cut the transition from the element with Ctrl+X (Windows) or Cmd+X (Macintosh).

3 If you want to copy the transition to another element, select the element on the Stage.

4 Move the Playhead to the location where you want the copied transition to start.

5 Press Ctrl+V (Windows) or Cmd+V (Macintosh) to paste the transition on the Timeline.

Learn more
• Creating and importing assets

• Creating animation

• Creating a flexible layout

• Create an animated logo

Adding text to your project (Tutorial)

Introduction
There are three ways to add text to your Animate project:

• Use the text tool. In the Tools palette, click the big T (or use the shortcut key T), and then in your document, click 
and drag to create a text box. Initially, you don’t have to worry too much about positioning or sizing the text box. 
You can manage those details later. Just go ahead and start typing. Try the phrase “ON the EDGE.” The text you enter 
appears on the stage, as shown in Figure 1. If you want to create multiple paragraphs, just press Enter (Return) as 
you would in your word processor. When you’re done, you can close the text window by pressing Esc or clicking the 
X button in the upper-right corner.

• Copy and paste. If you’re working with large blocks of text, you may have already worked up a draft in a word 
processor or some other source. In that case, you can copy the text in your word processor, and then in Animate 
create a text box and press Ctrl+V (Command-V) to paste it into your project. It won’t be formatted exactly as it was 
originally, but the text will be there. This process maintains some of the major formatting, such as paragraph breaks.

• Open HTML with text. Perhaps you have a web page already created in an HTML editor or some other web-building 
tool. You’d like to add some animation excitement to the static page. You can open that page in Animate using 
File?Open and then use Animate to make the elements move. You’re limited in what you can do with text imported 
in this way. You can’t edit it or change its formatting. In essence, it’s just another graphic element you can use in an 
animation. One significant advantage to this method is that links within the text are maintained.

http://www.adobe.com/go/learn_edge_animate_create_import_en
http://www.adobe.com/go/learn_edge_animate_animation_en
http://www.adobe.com/go/learn_edge_animate_layout_en
http://forums.adobe.com/docs/DOC-2536
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 Changing Text-Specific Properties
Once you have text in your Animate project, there are several text-specific properties that you can use to change its 
appearance, as shown in Figure 2. These properties appear in the Text subpanel. Initially, some of the less-used options 
may be hidden. Click the button in the lower-left corner of the subpanel to show and hide additional properties. The 
names for each of these tools follow CSS (cascading style sheet) naming conventions, so they are lowercase with 
hyphens between words.

• font-family. You can choose from several different typefaces. You might not find all the same fonts that you have on 
your computer. In web design, you’re limited to fonts that are available to your audience unless you have a way of 
providing the font with your project. For more details on fonts and typefaces, see the next section.

• color. Click the swatch, and the standard color picker appears where you can set the color for your text.

• font-size. Dial in font size by number. Next to font-size you see a button called Text Property Unit. Click this to 
change the method for specifying font-size.

• font-unit. Animate uses three different units for specifying font size: pixels (px) ems (em) and percentage (%). Pixels 
are equivalent to a single dot on a monitor. An em is roughly the size of the letter M. Most web browsers give users 
the ability to adjust the size of text, so an em is a unit that changes according to the browser setting. Percentage is a 
useful option when designing web content that may be viewed on mobile devices as well as desktop computers.

• font-style. Slants the text so it looks like italics.

• font-weight. Gives you several options such as Thin, Extra Light, Normal, and Extra Bold. The order of options and 
their accompanying numbers give you hints for comparing the different weights.

• font-decoration. Use this button to underline text.

• text-align. Just like your word processor, Animate lets you align text right, center, or left. Alignment affects all the 
text in the text box. So if you want to create one paragraph aligned right and one paragraph centered, they must be 
in separate text boxes.

• text-indent. Indents the first line within a text box. You can change the value in pixels. It doesn't accept negative 
numbers to create hanging indents.

• line-height. Use to set the space between lines of text.

• letter-spacing. As the name implies, you can adjust the space between letters. Often used to create distinctive 
headlines or company logos, this effect should be used sparingly for normal body text.
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• word-spacing. Varies the distance between words. Use carefully or you may end up with awkward, hard-to-read 
text.

 Using Web Fonts
 There’s another way to increase the number of typefaces you use in your Animate animations. For years, web designers 
have been using web fonts. For programs, including web browsers, to display a specific font, they need to have access 
to the font description. Usually, that description resides on the same computer as the program—sometimes called the 
client. Web fonts work a little differently. For example, with Google’s web fonts (www.google.com/webfonts), the 
definitions for the fonts are stored on Google’s servers. As a web designer, you can use these fonts by adding code to 
your pages that tell browsers where to find the font descriptions.

 First, find the web font you want to use. Google web fonts are free and surprisingly easy to use, so they’re a great 
candidate for your first attempt. Here are the steps to selecting a Google web font and grabbing the code you need to 
identify it in your project:

1  In your web browser, go to: www.google.com/webfonts. You see a page displaying font samples. There are hundreds, 
so the widgets on the left help you filter the fonts. The buttons at the bottom of the page direct you to the three steps 
for a successful web font hunt: Choose, Review, and Use.

2  On the left, below the word Filters, click the drop-down menu. Choose from Serif, Sans-Serif, Display, and Hand 
Writing. The menu uses checkboxes, so you can choose a combination of characteristics. For example, you could 
use Sans-Serif and Display.

3 If necessary, use the Thickness, Slant, and Width sliders to narrow your font search. With so many choices, it helps 
to thin the crowd of fonts displayed on the screen.

4 Use the tabs at the top of the font window to change the display to Word, Sentence, or Paragraph.

If you’re looking for a font for headings, the Word or Sentence tab is the best choice. If you’re choosing a font for 
body text, make sure you check its appearance with the Paragraph option.

5  Click the blue “Add to Collection” button. You can have more than one font in a collection, but for page-rendering 
speed and good design, you’ll want to limit the number of fonts you use.

6  Click Review. This step may not always be necessary, but as the name implies, on this page you can take a closer 
look at your font in use as a headline or paragraph.

7 Click Use. A new page loads with instructions for using the fonts on your web site. Part way down the page is a blue 
box with the heading “Add this code to your website”; see Figure 3.
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8 Click the Standard tab and then select and copy the code displayed. With the code stored on your clipboard, you’re 
ready and loaded for the second part of the process: adding the location for the font description to your Animate 
project.

Adding Web Fonts to Your Composition
Once you’ve chosen a Google or other brand web font and copied the code that identifies it, adding to your project easy 
in Animate. Here are the steps:

1 In the Library panel, on the bar that says Fonts, click the + button, as shown in Figure 4.

The Add Web Fonts dialog box appears.

2 Paste the code that identifies the location of your font in the lower “embed code” text box. This code is provided by 
the same organization that hosts the web font. If you followed the previous steps, the code is stored on your 
clipboard.

3 Type the name of web font in the upper Font Fallback List along with the fonts that should be used if the web font 
isn’t available. If the client computer isn’t connected to the Internet, then the web font won’t be available.

4 Click the Add Font button. The font now appears in the Font Name drop-down menu when you’re working with 
text.
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Changing Other Text Properties
Like any other element in Animate, you probably don’t expect your text to be static all the time. Fortunately for you, the 
designer, you don’t have to learn new tools to make your text dance around the screen. The X/Y Position properties 
determine where your text appears, and the W/HSize properties determine the dimensions of the text box. Keep in 
mind that the Size properties change the size of the text box, but they don’t change the size of the letters. To change the 
size of the letters, you can use the font-size properties or the Scale properties. Sometimes you'll want the size of your 
text to change depending on the size of the browser window. If that's the case, use % (percentage) for the Text Properties 
Unit. As with drawings and photos, you can create property keyframes in the timeline to make text properties change 
over time.

Remember those fold, spindle, and mutilate tools? You can use the Transform properties on text, too. Go ahead and 
rotate or skew blocks of text for special effects as you add or remove them from the web page. Use the Scale properties 
to make the text box and the text inside bigger or smaller. Scale works on text the same way it works on a JPEG image: 
Dial in a percentage, and everything grows or shrinks. Keep in mind that text gets a bit blurry when it is enlarged using 
the Scale property.

Clipping Text Around the Edges
As with other graphic elements on the stage, you can use Clip properties to hide the edges of a text box. It’s a lot like 
cropping the edges of photograph. Suppose you want animate a text box so that at first only a pinpoint in the middle is 
visible, then it grows to display an entire block of text. Select your text and then look near the bottom of the Properties 
panel. Click the triangle button to expand the Clip subpanel. In the upper-right corner of the subpanel, click the button 
to turn on clipping. Edge Animate provides four controls that represent the top, bottom, left, and right edges of the 
element (Figure 7). Type or scrub in values in pixels (px).

As you make changes, you see the effect they have on your text box. Want to remove clip properties after you’ve applied 
them? Just right-click (Control-click) the clipped element and choose Remove Clip from the shortcut menu.
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 Making That Headline Drop In
 In most cases, the purpose of text is to communicate a message, so it’s counterproductive to subject your audience to 
constantly moving and changing text. That doesn’t mean you can’t have a little bit of fun. For instance, you may want 
to have the heading on your web page drop down or bounce into place when the page first loads. In this project, you 
create a banner at the top of the stage. When the web page loads, three words—“ON the EDGE”—drop into place. In 
this case, you’re animating the phrase “ON the EDGE.” You break the words into three separate text boxes, so that you 
can move each word independently. In other cases, you may want to animate all the individual letters in a word or 
phrase. The toughest part of the trick is to get the letter or words to line up properly once they’re in place. You want 
letter spacing to look natural, and you want the text to sit evenly on a horizontal line. Often, when you’re animating 
words or letters like this, it helps to create a positioning template, and that’s exactly what you do in this project. The 
positioning template (Figure 8) is visible at design time to help you align those moving words and letters. When you’re 
done building the animation, you can remove the template.

 Here are the steps to create a drop-in heading:

1 Create and save a new 550 x 400 document with a white background color. As usual, create a new folder to hold the 
HTML and JavaScript files for your project.

2 With the Rectangle tool (M), create a rectangle 550px x 100px and place it at X=0, Y=0. Set the background color to 
R=200, G=210, B=250 and A=100%. Set border color to none. Give the rectangle the ID BannerBG. The quickest 
way to make a rectangle to spec is to drag out a quick box that’s any old shape and then type in the values in 
Properties. Make sure you click the link next to the W/HSize properties so you can enter nonproportional values.

3 In the Elements panel, click the Lock Element button next to BannerBG. A padlock appears next to BannerBG. Now, 
you can’t accidentally select or move the blue box on the stage.

4 Select the text tool and drag out a text box. Then type ON the EDGE. Set the font to Arial Black; the size to 72 px; 
and the alignment to Centered. This text will serve as a positioning template for the animated text.

5 In Properties, give the text box the name OnEdgeTemplate. As with your graphics, you want to be able to identify 
different blocks of text in the timeline and the Elements panel. At this point, the properties for the text look like 
Figure 9.
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6 Set the text box’s size and location to match the colored rectangle, with the size to 550px x 100px and the location 
to X=0, Y=0. When you’re done, the top of the Animate stage should look like Figure 10. If for some reason the text 
is behind the blue box, you can change the Z-order in the Elements panel. Just drag OnEdgeTemplate so that it’s 
above BannerBG.

7 Select OnEdgeTemplate and then press Ctrl+D (c-D). This duplicates the text, though you might not notice right 
away because it is placed right on top of the previous text. However, you can see OnEdgeTemplateCopy in the 
Elements panel.

8  Drag OnEdgeTemplateCopy down to the middle of the stage. In the next steps, you’ll use this to create individual 
text boxes with separate words: “ON,” “the,” and “EDGE.” Before that, it’s a good idea to finish setting up the 
positioning template. 

9 Select the original OnEdgeTemplate and then set the Text Color to red (#ff0000). As advertised, this text is being 
used for a positioning template. Later, the bright red color will make it easier to see if the text is correctly positioned.

10 In Elements, click the Lock Element button next to OnEdgeTemplate. This locks your positioning template in place 
so you can’t accidentally select or move it.
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11  Select OnEdgeTemplateCopy and press Ctrl+D (c-D) twice. This creates two more copies of the entire banner text.

12 Double-click the first OnEdgeTemplateCopy. In the text edit box, delete everything except the word “ON.” Then in 
Properties, rename the text ON. It’s best to eliminate extra spaces when you’re animating single words or letters and 
you should reduce the width the text box to fit the edited text.

13  Repeat step 12 to make text elements for the and EDGE. You now have three properly labeled words that you can 
identify and animate independently. You may want to resize the text boxes’ width to match the words, as shown in 
Figure 11.

14  Drag the word “ON” up so that it is above and slightly to the left of the stage. Drag the word “EDGE” so that it is 
above and slightly to the right of the stage. Drag the word the straight up so that it is above the stage. These are the 
starting positions for each of the words. They should be completely offstage.

15 Select “ON” and change the Rotate property to -30. Select “EDGE” and set the rotation to 30 degrees. These two 
words will appear to drop in at an angle from their respective sides.

16 Select all three words and click the Location and Rotate Add Keyframe buttons. The starting positions for each word 
are duly recorded in keyframes.

17  Drag the playhead to the half-second mark: 0:00.500. The entire animation will take a second, which is plenty of 
time for a simple animation like this. You don’t want to bore your audience. Each word will take a half-second to 
complete its move. Each word will start at a different moment.



32
Create animations using the Timeline

Last updated 6/15/2014

18 Select “ON” and set the Rotate property back to 0, and move “ON” over the same word in the positioning template. 
If you want to review the motion, drag the playhead back and forth. If necessary, you can readjust the start or end 
point. Just move the playhead into position and tweak the word’s position.

19 Move the playhead to 0:00.250. Then select the word “the” and click the Location Add Keyframe button. The plan 
here is to start the word “the” moving before “ON” has finished its movement. However, you want the word “the” to 
remain motionless for the first quarter-second, so you must create two location keyframes with identical values at 
0:00.000 and 0:00.250.

20 Drag the playhead to 0:00.750, and then move “the” over the same word in the positioning template. Use the 
Timeline Zoom slider to get a better view of the timeline. The units of measure at the top of the timeline change 
depending on the zoom level. (Figure 11)

No rotation is used for “the”, so this word will appear to drop straight down.

21 Move the playhead to 0:00.500. Select “EDGE” and click the Location and Rotate Add Keyframe buttons.

This keeps “EDGE” in place for the first half-second of the animation.

22 Move the playhead to 0:01, and then drag “EDGE” into place over the positioning template.

At the 1-second mark on the timeline, the words have finished their journey, and the first version of the animation 
is complete, except for removing the positioning template.

Before you remove the red positioning template, you probably want to preview the animation. Press Home and then 
the space bar to get a look. If necessary, you can continue to tweak the starting and ending points for the animated 
words. For example, you might prefer it if “ON” and “EDGE” drop in first and the word “the” is added last.

 Dealing with the Template 
The red positioning template isn’t meant to be a permanent part of the animation. So if you’re happy with everything, 
you can remove it. First turn off the Lock Element button to make the Template selectable. Then you can select the 
template in either the Elements panel or on the stage and press Delete. As an alternative, you could turn the template 
into a drop shadow (Figure 13) or glow effect for the text.
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• For a drop shadow, set the text to a mid-gray tone and then adjust the opacity to taste. Something around 30 percent 
usually works well. You might want to keep the drop shadow hidden until the three words have finished moving. If 
that’s the case, set the opacity to zero until that point in the animation, and then bring it up.

• For a glow effect, choose a yellow or orange color. Use the Scale control to make the text slightly larger than the text 
that drops in place. Again, you’ll probably want to use opacity to control the timing and appearance of the glow text. 
You might want the glow effect to fade in and then fade out, adding momentary emphasis on the heading.

 Adding Some Bounce
If the previous example, where text drops into place, is too sedate for your web page, you might want to consider adding 
a little bounce to the action. Bounce makes it seem like your web page adheres to the laws of physics. Like a basketball, 
your text can start with a big bounce and then one or two smaller bounces until it settles into place. You can create your 
own bounce by adding position keyframes, or you can create a bounce using the Easing properties that are part of the 
transition in the timeline.

 Creating a Bounce Manually
Open the file and examine the Elements panel—you’ll see the stage with three other elements. “BOUNCE” is the word 
that you’ll animate. “BounceTemplate” (red text) is the positioning template. As in the previous example, this marks the 
final position for the animated text. The ground element is a gray rectangle that’s positioned at the bottom of the stage. 
You can think of this as the ground on which the text will bounce.

A bouncing motion is created in the timeline by adding keyframes with alternating up and down locations (Figure 14). 
With the playhead still at 0:00, select BOUNCE and click the “Add Keyframe for Y” button in Properties. This sets the 
starting point. For the next leg of the journey, drag the playhead to 1:00 and move BOUNCE so that it covers 
BounceTemplate.
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Click “Add Keyframe for Y” to add new location keyframes. Drag the playhead to 1.75 and then move BOUNCE up 
near the middle of the stage. Move the playhead to 2.25 and then move BOUNCE back over the template. You can create 
a few more bounces using a shorter period for the motion—half a second, then a quarter second. With each bounce up, 
shorten the distance.

When you get tired of a straight up-and-down bounce, you can always add a little rotation to the movement, making it 
look like the word is bouncing back and forth off of the lower corners. If you reduce the vertical scale property when 
the text hits the ground, you can create a cartoon-like smooshing action, as if the text were compressing on impact with 
the ground.

 Using Animate’s Prebuilt Bounce
First, a little background about transitions and the concept of easing. When you animate an element on the stage, by 
changing properties and creating keyframe properties in the timeline, you create transitions. Those transitions are 
shown visually as bars in the timeline. Like the elements on the stage, transitions have properties, too. One of the 
properties is called Easing. In the real world, when objects move, they accelerate and decelerate. You never see a car 
begin to move at full speed or come to a stop instantly. The Easing properties help you create more realistic movement 
by automatically controlling an element’s transition. It just so happens that one of the easing options helps you to create 
a bouncing motion.

Here are some steps to explore transition properties:

1  Drag the playhead to 0:01, and then drag BOUNCE down so that it covers BounceTemplate. Animate creates a 
transition in the timeline.

2 In the timeline, click the transition lane next to BOUNCE. The transition in the timeline is highlighted. 

3 At the top of the timeline, click the Easing button. The easing panel appears above the timeline. Initially, the tooltip 
for this button says Easing: Linear, because that is the easing method that’s applied. With linear easing, the transition 
is applied at a steady rate from beginning to end.

4 On left side of the Easing panel, click Ease Out. Then, on the right, click Bounce, as shown in Figure 15. When you 
click Ease out, the panel displays a number of Ease Out methods. The graph gives you a visual representation of the 
easing method.
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5 Click outside of the Easing panel. The panel closes and your easing method is applied to the selected transition.

6 Press Home and then the space bar.

When the animation plays, you’ll notice some nice bouncy action at the end of the motion. If you’d applied 
EaseInBounce, the bouncing motion would have occurred at the beginning of the transition.

The easing properties for transitions can be a real timesaver. Animate includes a number of different transitions, but 
sometimes the names are a little cryptic. The best way to learn the different easing characteristics is to create a 
practice animation and apply different eases to identical elements and transitions.

 Building Your First Animation
1 Start Animate and go to File?New to create a new document. When you create a new document, you start off with 

an empty stage. You see “Stage” as the only element listed in the Elements and Properties windows. As you see in the 
Properties panel, the stage has dimension, color, and other properties. You’ll learn more about each of these 
properties later.

2 Create a folder for your project and then choose File?Save As to save your file with a name like Hello_World or 
First_Try.

You can create a folder outside of Animate using Windows Explorer or Finder, or you can create a new folder as part 
of a File?Save As command. It’s a good practice to save your Animate project immediately with a helpful name. That 
way you won’t end up with a bunch of “untitled” projects that you don’t remember. Also, it makes it easy to save your 
work early and often with a quick Ctrl+S or Command-S. It’s best to save each Animate project in its own folder 
because Animate creates several files and an edge_includes folder when you first save a project.

3 In the Properties window, click the white Background Color swatch. A panel appears where you can choose a color 
(Figure 16). If you prefer a strictly visual approach, click the spectrum bar at the left for a basic hue and then click 
inside the square to fine-tune your selection. In some cases, you may have a specific color specification in RGB (red-
green-blue) format or as a hexadecimal number.
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4 When the color picker appears, choose a dark blue color to represent deep space. If in doubt, try R=30 G=45 B=90 
A=100 for this project. Animate uses Adobe’s standard method for choosing numbers. When you see a highlighted 
number, that means you can either click and then type in a number, or you can click and drag to “scrub” in a number. 
Drag right to increase the number, left to decrease.

5 Still in the Stage properties panel, change the Overflow to hidden. The Overflow property controls the visibility of 
items when they are viewed in a web browser. On a web page, the stage may represent just a portion of the entire 
web page. You can control the visibility of elements outside of the stage's rectangle. Change this property to hidden 
when you don't want to see elements that are offstage.

6 Choose File?Import. Using the Import window that appears, find and select an image, like a planet earth, for 
example. Click Open to import the image into your project.

After you import a file to your Animate project, it is listed in the Elements window and is displayed on the stage. It’s 
automatically selected, so you see the properties for the newly imported element in the Properties window. The 
“planet_earth” has visibility properties at the top of the panel. Right below are Position and Size properties. Below 
those, you see the Transform properties that let you rotate, skew, and scale elements. Below that, the source file is 
listed—a handy point to keep in mind when you’re trying to remember, “What the heck was the name of that file 
anyway?”

7 In the Properties panel, click the ID box at the very top and change planet_earth to World.

As Animate imports graphics, it names them using the file name. In some cases, that may be fine, but often you’ll 
want to rename the element inside of Animate. Keep in mind this doesn’t change the filename of your graphic. The 
ID World is used when you’re working in Animate. IDs serve an important function in HTML code, as you’ll learn 
later in this book. Notice that in the Elements panel your World appears with its new name. Because it’s on the stage, 
World also appears in the timeline.

8  In the timeline, make sure the playhead is at 0:00. If you haven’t made any timeline changes since you created this 
project, the playhead is at 0:00, marking the first moment or frame of the animation, as shown in Figure 17. If you 
need to move the playhead, drag the gold-colored, bottom part of the playhead. The top part is called the pin. It 
should follow automatically.

You’ll learn more about the two-part playhead in the following steps.

9 Drag the World past the bottom of the stage. As mentioned in step 5, you can control whether offstage items are 
displayed on the web page. With Overflow set to hidden, when you're in the Animate workspace, offstage elements 
appear a little darker than usual. When the final project is viewed in a browser, these elements will be hidden.
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10 In the timeline, make sure that the Auto-Keyframe Mode button is pressed. When the Auto-Keyframe Mode button 
(Figure 17) is pressed, keyframes are automatically created in the timeline as you make changes to element 
properties. Keyframe markers look like diamonds.

11 In the timeline, make sure that the Auto-Transition Mode button is pressed. When this button is pressed, Animate 
creates smooth transitions instead of abrupt changes. In this case, the World graphic will smoothly move from one 
position to another.

12  Drag playhead to 0:01 on the timeline. In the timeline, 0:01 marks 1 second into the animation. A red line extends 
downward from the playhead, providing a marker for all the element and property layers. 

13 With the World still selected, in the Properties panel, go to Position and Size and click the diamond shaped buttons 
next to X and Y. Two diamond-shaped keyframes appear in the timeline marking the position for the Left and Top 
edge of the World graphic. The X and Y properties set the position of elements on the stage. By clicking the diamond 
next to Location in the Properties panel, you manually recorded the World’s location on the stage. As a result, the 
World stays in the same X/Y position for the first second of the animation.

14 Click the Toggle Pin button, then drag the bottom, gold part of the playhead to 0:03. To animate an element, you 
change its properties over a specific period of time. The playhead and the pin let you mark two points in time, as 
shown in Figure 18.

15  Drag the World graphic so that Earth is visible on the stage. You can center the image on the stage, or you can choose 
some other eyepleasing layout.

16 Click the Toggle Pin button, then press the Home key and then press the space bar. When you press Home, the 
playhead returns to 0:00. Pressing the space bar plays your animation so you can preview the action on the stage.
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17 Move the playhead back to 0:00, and then in the toolbar, click the letter T. The text tool is selected, and the cursor 
changes to a cross.

18 Click on the stage and type Hello World. When you're done, close the text window by pressing ESC or clicking the 
X button in the upper-right corner. The words “Hello World” appear on the stage, but they’re probably not 
positioned or formatted as you want.

19 In the Properties window, set the ID for the text box to HelloWorld. Naming your text makes it easier to identify in 
the timeline and the Elements panel. Animate doesn’t permit space in names, so you need to use HelloWorld or 
Hello_World.

20 Using the Properties panel, format the text. Change the text color to white or a very light blue. Choose Arial Black 
or another bold font. Adjust the size so it nearly fills the screen (72 px works well with Arial Black). Animate notes 
each change to the text in the timeline, adding property layers and creating keyframes.

21  Position the text. If you’re not sure about the placement, try it centered horizontally and about a third of the way 
down the stage.

22 With the playhead still at 0:00, set the opacity to 0. The Opacity slider is at the top of the Properties panel. This means 
the text will not be visible at the beginning of the animation. Only the selection box shows and that will disappear 
as soon as you click something else. Don’t worry, though—you can select any element, whether it’s visible or not, by 
clicking its name in the Elements panel.

23 Make sure Toggle Pin is turned off. When Toggle Pin is off, the button doesn’t appear pushed in and the pin moves 
with the playhead.

24 Drag the playhead to 0:02. With the text selected, click the diamond next to Opacity in the Properties panel. As you 
drag the playhead, you see the World move on the stage. Filmmakers and animators refer to dragging the playhead 
as scrubbing, a quick and easy way to review a segment of your animation. Clicking the Opacity diamond creates a 
keyframe at the 2-second mark where the text is still invisible.

25 Turn Toggle Pin back on, then drag the playhead to the 0:03 mark. With the pin at 0:02 and the playhead at 0:03, 
you’re ready to create another transition.

26  With the HelloWorld text box selected, set its opacity to 100. Animate creates a transition so that the text gradually 
changes from 0 to 100 percent opacity between 0:02 and 0:03 in your animation.

27  Drag the pin to the 0:03 mark, then drag the playhead to 0:04. Set the opacity back to 0. The text disappears again.

28  Press Ctrl+S (Command-S) to save your work.

 As explained earlier, Animate saves your animation as a collection of HTML and JavaScript files. The main HTML 
file uses the name you provided in step 2, when you first saved your project. So, for example, you may see 
Hello_World .html in the project folder. When you imported the planet_earth.png image, Animate created an 
images folder and placed a copy of the graphic in the folder. Your simple animation is complete. You can preview it 
in Animate by pressing Home and then the space bar. The earth rises into view, and your message fades in and then 
fades out (Figure 19). The entire animation takes 4 seconds.
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 Setting the Stage
As the Bard said a few hundred years ago, “All the world’s a stage.” That’s certainly true in Edge Animate. As explained 
in Chapter 1, when you place an element on the stage, it’s visible to your audience. There are a couple of ways to hide 
or remove elements from the stage. If you have the stage Overflow properties set to hidden, then you can exit stage right, 
left, top, or bottom by moving the element off stage.

At least, it’s not visible when viewed in a browser. The stage that you work with in Edge Animate represents a portion 
of a web page when it’s viewed in a browser. The stage has a limited number of properties. The most obvious are its 
dimensions and background color, but you’ll want to understand them all. Here’s the rundown starting from the top of 
the Properties panel:

• The ID, as you might guess, is the name of your animation. When you save a project, Animate creates a web page, 
also known as an HTML document. Most browsers show the ID of the web page in a tab or the window’s title bar.

• Initially, stage dimensions are shown as W (width) and H (height) properties in pixels. No big surprises here. You 
can type in or scrub in the width and height of the stage. The stage doesn’t have to appear in the upper-left corner 
of a web page. For example, if your Animate composition is a banner ad, you might create a tall, narrow stage and 
then position it on the left side of the page. Use the link next to the W and H properties to lock and unlock your 
stage’s aspect ratio. When Link Width and Height are unbroken, changing one dimension automatically changes the 
other so that the stage stays proportionate; when the link is broken, you can change W and H independently. You 
can change the measurement from pixels (px) to a percentage (%). For example, if you set the stage width to 80%, 
the stage will be 80 percent the size of the web browser window that it’s viewed in. This feature is great if you’re 
developing a page for computers, tablets, and phones. What’s more, if the browser window is resized, the stage 
automatically adjusts to the new size.

• The background color is set using a color picker. In the Properties panel, click the color swatch and a color picker 
appears, as shown in Figure 20. Click the bar (also called the spectrum) on the left to choose a hue, and then click 
in the larger square to fine-tune the shade. The circle is positioned over the selected color, and the swatch in the 
lower-right corner displays it. The three swatches at top right make it easy to quickly choose a white, black, or 
transparent background. If you work with a team, you may be given a color spec in RGB or hexadecimal formats. 
On the other hand, if you’re calling the shots, you may want to specify a color for other designers.
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• Use Min W and Max W to set the minimum and maximum width for the stage. Web pages aren’t a fixed size. Your 
page may be viewed on a smartphone or a big screen TV. On top of that, your audience may resize the browser 
window. You can gain some control over how your project looks by setting a minimum and maximum width. You 
can use pixels to set an absolute value or you can use a percentage for responsive designs. Initially, Max W is set to 
none. To turn it on, click the label and deselect none. At that point the value appears in the panel and you can make 
adjustments.

• The Overflow menu controls the way elements appear when they’re offstage. Often, you’ll want to set this menu to 
hidden, which makes elements outside the stage’s rectangle invisible. The hidden option works well when you want 
to have elements enter and exit the stage. If you set the menu to visible, elements that move beyond the boundary of 
the stage remain visible as long as there’s room on the web page. The scroll option places scroll bars at the right and 
bottom of the stage, making it possible to view elements that move outside the specified dimensions of the stage. 
The auto option automatically adds scroll bars if content exists beyond the confines of the stage.

• Use the Autoplay checkbox to tell your animation to automatically run when its web page is loaded in a browser. If 
the box is turned off, you must use a JavaScript trigger to run the animation.

• The Composition ID is used to identify this particular stage and its accompanying timeline. This becomes 
important when you have more than one Animate composition on a single web page. You’ll learn more about this 
in the JavaScript chapters.

• The Down-level Stage and Poster properties create alternative elements for web browsers that aren’t HTML5 savvy.

• The Preloader is responsible for loading all the resources needed to display your composition on a web page. Those 
resources include JavaScript libraries and graphics.

 Creating Art in Animate
 The next section describes in detail the properties of the rectangle. However, many of these properties are used by other 
objects, such as blocks of text and artwork that you import into Animate. So when you’re learning all about rotating, 
skewing, and scaling rectangles, keep in mind that you can rotate, skew, and scale text and photos, too.
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 Rectangles: Building a Basic Box
Using the Rectangle tool (M), you can add blocks of color to the stage. These blocks are great if you want to differentiate 
portions of the web page. For example, perhaps you want to make a sidebar. Add a rectangle, and then you can place 
text or graphics over the rectangle, setting it off from the rest of the page. Chances are you know the basic drill for 
creating a rectangle. Click the Rectangle tool on the Tools palette, and then click and drag on the stage to mark its shape. 
To create a square, hold the Shift key while you drag. The new element appears on the stage, and it’s automatically 
selected, so you see eight white squares around the border that represent handles (Figure 21). You can continue to 
change the size and shape of the rectangle after it’s drawn by dragging the handles. Here are the basic properties that 
describe your rectangles:

• ID. As soon as you draw a rectangle on the stage, it’s listed in the Elements panel. When the rectangle is selected, its 
properties appear in the Properties panel. As with all your Animate elements, you probably want to give your 
rectangle a meaningful ID, such as LeftSidebar or Header. Otherwise, you’ll be searching through Rectangle1, 
Rectangle2, and Rectangle3 trying to find the one you want. To rename your rectangle, select it and change the ID 
at the top of the Properties panel. As an alternative, you can double-click the name in the Elements panel.

• Tag. Check out Rectangle in the Elements panel and see <div> after the name. Your rectangle is automatically 
assigned an HTML <div> tag. Animate uses these tags to identify, position, and transform elements. With other 
Elements, Edge Animate lets you choose different tags. For example, when you add a photo to your animation, there 
are good reasons to use a <img> tag instead of <div>.

• Position. Underneath the name in the Properties panel, you see the Position and Size properties. The upper-left 
corner of the stage is referenced as X=0, Y=0. Moving from left to right increases the X value. Moving from top to 
bottom increases the Y value. Initially, your rectangle’s position is referenced by the upper-left corner. You can 
change that reference point, using the “Relative to” tool. It looks like a box with a square at each corner. Suppose you 
need to position an element a certain distance from the lower-right corner of the stage: you may want to use the 
lower-right corner of your element as a reference point. In that case, just click the lower-right square in the “Relative 
to” box.

• Size. Next to the Location properties are the Size properties: W (width) and H (height). These change automatically 
when you drag a rectangle’s handles. You can also type in or scrub in a specific number. Initially for rectangles, the 
size properties use pixels as the unit of measure. However, you can change from pixels to percentage. So a rectangle 
with a width of 20% would be 20 percent of the width of the stage. Use the link next to the W and H properties to 
lock and unlock the aspect ratio for your rectangle. When the Link Scale is unbroken, changing one dimension 
automatically changes the other so that the rectangle stays proportionate. When the link is broken, you can change 
W and H independently.

• Display. Some elements are always on stage while others may come and go. The Display menu gives you a way to 
easily hide an element until it is needed. Your three choices include: Always On, On, and Off.

• Overflow. The overflow control for your rectangle works like the one for your stage, except it explicitly applies to 
the rectangle.

• Opacity. Use the slider near the top of the Properties panel when want to control the Opacity of the entire rectangle. 
When you want to adjust the opacity of the border or background independently, click their color swatches 
(explained under Color) and change the A (alpha property).

• Color.Rectangles have two basic parts: border color and background color. Border color marks the outer edge of the 
rectangle, while background color is the color inside the box. (Other programs sometimes call these properties 
stroke and fill.) You can assign separate colors to the border and background, or you can make them transparent by 
setting the Alpha channel to zero. There are two additional properties for the stroke. You can set the size in pixels 
(px) and you can choose among a solid stroke, a dashed stroke, a dotted stroke, or none—no stroke at all. The toolbar 
at the top of the workspace gives you another way to quickly change the background and border color of a selected 
element. It works just like the color picker in the properties panel.
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 Aligning, Distributing, and Arranging Elements
The maxim that “everything has its place” is certainly true when it comes to animation. With more than one element 
on the stage, their relationship to each other is critical. Designers often have a specific grid in mind when they’re 
creating printed pages or web pages. It’s best when boxes of text or graphics are aligned with this invisible grid. When 
several elements are aligned, it usually looks best when there’s an equal distance between them. You can spend a lot of 
time eyeballing the stage to try to get everything just right, but fortunately, you don’t have to.

To experiment with Animate’s Arrange, Align, and Distribute tools, you may want to create three or four simple objects 
from the Rectangle and Rounded Rectangle tools like the ones shown in Figure 22. As you drag elements around the 
stage, you’ll notice magenta-colored lines sprouting from the edges and midpoints. These are Smart Guides, and they 
can help you to quickly align one or more objects while you’re mid-move. In many cases, that may be all the help you 
need.

For more formal alignment needs, turn to the Modify?Align menu. For align to work, you need to select at least two 
elements. One of those elements may be the stage. You can select the elements on the stage or you can use the Elements 
panel. To use these commands, select all the elements that you want to align and then choose one of the options:

• Modify?Align?Left

• Modify?Align?Horizontal Center

• Modify?Align?Right

• Modify?Align?Top

• Modify?Align?Vertical Center

• Modify?Align?Bottom You use the Modify?Distribute commands to put equal distance between three or more 
elements on the stage. You can choose which part of your elements the distribute command uses for the process and 
whether the action takes place along the horizontal or vertical axis. The specific commands are:

• Modify?Distribute?Left

• Modify?Distribute?Horizontal Center Modify?Distribute?Right

• Modify?Distribute?Top

• Modify?Distribute?Vertical Center

• Modify?Distribute?Bottom
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 Rulers and Manual Guides
The stage includes rulers that help you place elements with precision. You can show and hide the rulers using the View 
menu (View?Rulers) or with the shortcut key: Ctrl+R (Command-R). The rulers extend beyond the edges of the stage, 
but there are markers that indicate the stage’s current size. For help with alignment chores, create guides by clicking on 
either the horizontal or vertical ruler and dragging toward the stage. Your guide follows and stays in place when you 
release the mouse button. If that’s not the perfect spot, you can drag your guide to a new location. When you no longer 
want a guide, you can remove it by dragging it back to the ruler. To avoid inadvertently selecting and moving a guide, 
use the View?Lock Guides command.

This locks them in place until you use View?Unlock Guides to free them again. For quick help with alignment work, 
turn on Snap to Guides (View?Snap to Guides).

You can drag multiple guides onto the stage for various alignment duties and you can show and hide all the guides at 
once using the View?Guides command (Ctrl+; or Command-;).

 Arranging Elements: Z-Order
In addition to horizontal and vertical position, there’s another way you can arrange objects on your stage. As you create 
elements, you may notice that new elements appear to be in front of the older elements, and if you drag a new element 
to the same X/Y position on the stage, it hides an older one. If you’re familiar with Photoshop, you might think of this 
positioning as “layers.” In geek-speak, it’s often referred to as the Z-layer or the Z-order, because this third dimension 
is known as the Z axis.

You can examine the Z-order of the elements on the stage by simply looking at the Elements panel. Elements at the top 
of the list are closer to the front. If you want to change the order, just drag an element to a new position in the panel. 
Animate also gives you menu commands and shortcut keys to rearrange elements:

• Modify?Arrange?Bring to Front (Ctrl+Shift+] or Shift-Command-])

• Modify?Arrange?Bring Forward (Ctrl+] or Command -])

• Modify?Arrange?Send Backward (Ctrl+[ or Command -[)

• Modify?Arrange?Send to Back (Ctrl+Shift+[ or Shift- Command -[)

 A Rectangular Animation
Roll up your sleeves. Enough theory, it’s time for some animation. In this exercise, you create four rectangles. You give 
them names, apply color, and skew them.

Then you position them on the stage and make them move, change shape, and then appear to dissolve. It’s the sort of 
effect that might be part of a banner ad or the introduction to a more complex animation.

This exercise is divided into two parts. In the first set of steps, you create and position the color bars:

1  Open and save a new Animate project with the name Color_Bars. Don’t forget to create a new folder for your 
project.

2  Set the stage color to white and the dimensions to W=550 px and H=400 px. Animate remembers the last stage 
settings you used. So if you followed previous exercises or experimented on your own, you may need to make these 
changes.



44
Create animations using the Timeline

Last updated 6/15/2014

3 In the timeline (Figure 23) make sure that the Auto Keyframe Mode and Auto Transition Mode buttons are pressed. 
If you move your cursor over the buttons, tooltips show their names. For example, at the top of the timeline you see: 
Auto-Keyframe Mode, Auto-Transition Mode, Toggle Pin, and Easing.

4 Draw a rectangle and in the Properties?ID, type Red. The ID box appears at the top of the Properties panel when the 
rectangle is selected.

5 In Properties, click the background color and set it to pure red, and set the to none. When you’re done, the hex color 
number should be #ff0000.

6 Set the rectangle’s size to W=550px and H=100px. The quickest way to accomplish this is to type the dimensions in 
the Properties panel, but if you’re a mouse master, you can drag the rectangle’s handles. You may need to click the 
“link” button next to W and H to change the width and height independently.

7 Set the Skew (x) to 50 deg (degrees). The horizontal skew is the top setting. A positive number slides the top edge 
to the left and the bottom edge to the right.

8  Position your red, skewed rectangle in the top-left corner of the stage so that only its point tip is visible. The 
Location properties should be X=-550px, Y=0px. Ideally, just a red triangle shows in the top-left corner of the stage.

9 With the Red rectangle selected, press Ctrl+D (Command-D). Change the ID of RedCopy to Green. Then, change 
the color to match. The hex value for solid green is #00ff00. You can change the background color of a selected 
element in the Properties?Color subpanel or you can use the color swatches in the toolbar above the stage.

10  Line up the top of the green rectangle with the bottom of the red rectangle (Y=100px). Then, hold the Shift key 
down and slide Green to the right until only the tip shows (X=430px).

 Holding the Shift key down while you move an element helps to lock it to the horizontal or vertical axis as you drag 
it. You can still drag it off axis, but it’s a little “sticky.”
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11  Create two more skewed rectangles, naming and coloring them Blue and Yellow. Position the rectangles on 
alternating sides of the stage. The blue color is #0000ff, and yellow color is #ffff00. When you’re done positioning 
the rectangles, the stage should look like Figure 23.

 Animating by Adding Property Keyframes
Now that you’ve successfully created and positioned the color bars, it’s time to make them move. Chapter 1 showed how 
the position of elements on the stage is controlled by property keyframes in the timeline. When the Auto-Keyframe 
Mode button is pressed, as shown in Figure 23, new property keyframes are created whenever you set or change a 
property. You can also create property keyframes manually by clicking the diamond-shaped buttons in the Properties 
panel. You want to lock in the Position, Size, and Opacity properties at the beginning of your animation by creating 
property keyframes. Then you’ll move down the timeline and create different property keyframes. The result will be 
animation magic.

1 Make sure the timeline’s playhead is at 0:00. Select the parallelogram named Red; then in the Properties panel, click 
the diamond-shaped buttons next to X, Y, W, H, and Opacity.

The X and Y properties are in the Position and Size subpanel. They control the position. The W and H buttons create 
keyframes for width and height. The Opacity slider is near the top of the Properties panel. The diamond buttons add 
property keyframes and individual property layers in the timeline as you can see in Figure 24. Property keyframes 
anchor a specific property value at a specific point in time. In the timeline, you should see property keyframes and 
property layers for:

• Left

• Top

• Width

• Height

• Opacity

If you don’t see all those keyframes and property timelines under Red, you should create them manually by clicking 
the diamond button next to the missing property.

2 Repeat step 1 for the Green, Blue, and Yellow color bars to create the property keyframes and property layers for 
each. To speed things up, you can select all three bars first and then click the keyframe buttons.

3 Make sure the Auto-Keyframe Mode and Auto-Transition Mode are on (pressed in) and the other buttons are not. 
When Auto-Keyframe is on, Animate automatically creates property keyframes as you change elements on the stage. 
It’s a two-step process. Move the playhead to a point in time and then change your element’s properties. You can 
make changes in the Properties panel or you can make changes on the stage with the Selection and Transform tools.

4  In the timeline, drag the playhead to the 0:02 position. For this step, the pin should be toggled off (not pressed in).
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5  Drag each of the rectangles across the stage until the tail end of the skewed rectangle is visible.

 At this point, most of the stage is covered by the color bars, with white triangles of the stage showing through at the 
edges. Remember to press the Shift key as you drag if you want to steady the bars’ vertical position.

6 With all the rectangles selected, in Properties click the Add Key Keyframe for Opacity button. Drag the playhead 
back and forth to preview the animation. The opacity for each color bar is set to 100 percent at the 2 second point. 
Scrubbing the playhead gives you a quick look at the action.

7  Drag the playhead to the 0:03 marker. This position represents the point 3 seconds into your animation.

8 Select each rectangle and then change the height (H property) to 300 px and the opacity to 50 percent. This has the 
effect of making the rectangles grow, slicing vertically into one another, and at the same time start to blur. See Figure 
25. Keep in mind, you may need to delink the W and H properties to change them independently.

9  Drag the playhead to the 0:04 marker. Then change each rectangle’s height to 500 px and the opacity to 0 percent. 
The effect is that the rectangles keep growing and blur out of view.
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 Rounded Rectangles: More than Meets the Eye
OK, Animate pulls a fast one when it comes to the Rectangle, Rounded Rectangle, and Ellipse tools. The dirty little 
secret is that you can create all these shapes using the Rectangle tool and tweaking the properties. The reasons for this 
quirk have to do with the fact that JavaScript code is defining these shapes. You can check this by creating a shape with 
each tool and examining their properties. You can turn a rectangle into a rounded rectangle simply by adjusting the 
Corners?Radius properties, as shown in Figure 26. Likewise, you can square off a rounded rectangle using the same 
tools. So here’s a look at how they work.

In a new Animate project, create a rectangle and leave it selected. Choose the Transform Tool (Q), then with the mouse, 
hover over the keyframe diamond in the rounded rectangle properties, and the tooltip explains that it will “Add 
Keyframe for Border Radii.” The three buttons at the top of the panel are labeled 1, 4, and 8. Below, you see a square 
made up of buttons where you can individually select the four corners of a rectangle. There’s a number next to the 
corner buttons that’s initially set to 0. A corner radius of zero means your rectangle has nice, sharp-edged corners. Click 
on the number and drag to the right to round off the corners. The number box accepts only positive numbers, so you 
can’t drag left. Notice that as you drag, the black diamonds at the corners of your rectangle move to the center. These 
diamonds are control points for the corner radii. You can manually drag the diamonds on any rectangle to create and 
adjust rounded corners.

Reset your rectangle so that it’s square, and then click the upper-right corner in the Properties panel. Change the radius 
setting and this time, you notice that the upper-right corner remains square while the others take on the rounded style. 
When a corner button is pressed in, that deselects the corner from the rounded settings.

Reset the rectangle once more and click the upper-right corner so it pops back out. Then click the 4 button at the top 
of the corner properties. Four new number boxes appear next to each corner. Now you can set each corner 
independently with different radius values. This gives you the ability to create irregular shapes even though, technically, 
they still have four corners. Combine this with the skewing and scaling properties, and you can create some really 
interesting amoeba effects. Click the 8 button, and each corner has two control numbers. This gives you the ability to 
move the control point off center, making a corner that is flatter on one side compared to the other. Notice that when 
you adjust the settings, the black diamond control point moves, too. You can always adjust your corners using either 
the number boxes or the control points in the rectangle.

 A Circle Is a Very Rounded Rectangle
You can experiment with the Corners?Radius properties by turning Rectangles into ovals and circles. For example, here 
are the steps to turn a square into a circle:

 

1 Click the Rectangle tool and, while holding the Shift key, drag out a box. Holding the Shift key down constrains the 
rectangle so that all sides are equal.

2 In the Corners properties, click the 1 button. With this setting, all the corners share the same corner radius value.

3  Click and drag the border radius number box until the square turns into a circle, as shown in Figure 27.
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 It’s possible to drag the number so that the corner radii pass one another at the center, but that’s not necessary to 
create a circle. You can change and adjust your circle properties just as you would any other object that you create 
in Animate. By skewing your object, you can create ellipses. By scaling it, you can create ovals. And, of course, you 
can create anything in between a square and an ellipse with the right settings.

 Adding Drop Shadows to Graphics
 Drop shadows not only look cool, they give you a way to visually separate different elements. Apply a drop shadow to 
a graphic, and you make it look like it’s floating above the stage. Add a shadow to the interior of an element, and you 
give it a more three-dimensional appearance. Shadows are often used with buttons to create a different appearance for 
over, clicked, and selected states. Animate gives you an easy way to create drop shadows and modify them to your needs 
and taste.

For a subtle shadow that sets an element off from the background, try the following steps:

1  Draw three elements on the stage.

2 Select one and then in the Properties panel, scroll down to the Drop Shadow controls shown in Figure 28.

3  Click the color swatch and choose Black.

4 Click the horizontal offset and type 4.
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5 Click the vertical offset and type 4.

6 Click the Blur radius and type 14.

7 Click Spread and type 2.

If you want one of the elements to look three dimensional, you can use the same settings but click the Inset button. 
Instead of appearing outside of the element, the shadow is created inside the element. As the name implies, the 
Spread property controls the size of the shadow making it spread in all directions. As with any other property, you 
can make the drop shadow change over time. With a little creativity, you can create the impression of the sun 
changing position in the sky, with shadows moving and changing shape. Shadows are an important tool for text, too: 
text is more readable over a busy background when separated by a shadow.

 Importing Art
It’s easy enough to create basic shapes and text in Animate, but when it comes to complex artwork, you’ll probably turn 
to your favorite art creation tools. For elaborate drawings and line art, that may be Adobe Illustrator. For photographs, 
you may use Photoshop, Lightroom, or iPhoto. Adobe Fireworks may be the ideal companion tool for Animate because 
both tools were designed to create Web content. No matter how you create JPEGs, GIFs, PNGs, or SVGs, you can 
import them into Animate and then animate them by changing their position on the stage and their appearance.

Regardless of the file format, the process for importing artwork is the same. Go to File?Import and then find the file 
you want to bring into your project. The Missing CD folder 02-2_Sliding_Show has three photos in JPEG format. You 
can practice by creating a new project complete with a new folder named 02-2_Sliding_Show and import each of the 
photos. After you choose File?Import, a standard file/folder window opens for your PC or Mac. If you want to import 
all three files at once, just Shift-click to select them. As usual, Animate imports the files and, as a handy timesaver, 
names them based on the filenames. In this case, you’ll find squirrel, farmhouse, and bike in your Elements panel. Each 
image is also automatically placed at the 0,0 position on the stage. You’ll only see one of the images though, because 
they’re covering one another.

 Choosing between GIF, JPG, PNG and SVG
The world of 2D computer graphics offers two systems for storing and displaying images: bitmaps (technically called 
raster graphics) and vector graphics.

Computer programs store bitmaps as a bunch of pixels, identified by color and position. The term Bitmap graphics 
doesn’t refer to just files with the Windows bitmap (.bmp) extension; it refers to all images stored in bitmap format, 
including .gif, .jpg, .tiff, and .png.

The good thing about bitmap graphics is that they let you create super-realistic detail with complex colors, gradients, 
and subtle shadings. On the downside, uncompressed bitmaps typically take up a whopping amount of disk space, and 
they’re not particularly scalable. For example, suppose you have a bitmap image of a car, and you tell a program to 
increase the size by 500 percent.

The program has to create new pixels for the bigger image, so it duplicates the pixels (colored dots) already in the image. 
The results aren’t always pretty. The entire image is likely to appear blurry. The curved edges may become blocky or 
pixelated.

Computers store vector graphics as a bunch of formulas. Compared to raster graphics, vector graphics are relatively 
modest in size, and they’re scalable. In other words, if you draw a tiny car and decide to scale it 500 percent, your scaled 
drawing will still have nice, crisp details.
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The strengths and weaknesses of each format are important when you’re working with images. Bitmaps are better for 
photorealistic images with lots of colors and shades. Vector graphics are better for line art, charts, diagrams, and images 
that you’re going to scale to different sizes. Animate can import four types of graphics files—JPG, GIF, PNG, and SVG—
however, there are a couple of gotchas that might surprise you.

JPG files, also known as JPEGS, are the familiar bitmap format used on the web and in many cameras. The format was 
developed by the Joint Photographic Experts Group, hence the acronym. JPEGs use what is known as a lossy 
compression technique to create smaller file sizes. Image editors that work with JPEGs usually let you choose the degree 
of compression. If your image will only be viewed on a screen, you can crank up the compression. If it’s headed to a 
photo printer and you want it poster size, you’re going to need all those pixels.

GIF files were developed by CompuServe, one of the early online services. The acronym comes from Graphic 
Interchange Format. GIFs’ popularity seems to be fading compared to JPEGs and PNGs, but you’ll still find them on 
many websites. GIFs are bitmaps stored with a lossless compression technique, but use a limited color palette. The result 
is that an image with big swaths of solid colors, like a company logo or a bar graph, might result in a very small file. On 
the other hand, a photographic image won’t compress as well and may not look as good in GIF as, say, in JPEG because 
of the limited number of colors. GIFs provide a couple of neat tricks. You can create animated GIFs using simple frame-
by-frame animation. Programs like Adobe Fireworks and

Flash make the process fairly easy. GIFs also let you designate parts of the image as transparent. That’s great if you’re 
placing an irregular shape, like an animated character, over an already developed background, like a room’s interior.

PNG files were developed at a time when there were patent issues regarding GIF. Pronounced “ping,” this abbreviation 
stands for Portable Network Graphics. The PNG format was designed to be used on the Web (as opposed to print 
graphics) and to improve upon features already popular in GIFs. PNGs use a lossless compression technique, provide 
a bigger color palette, can display animated sequences and can include transparency within the image. PNGs are well 
supported among modern web browsers, but there are probably still some older browsers out there that don’t handle 
the format. The PNG format works well with Animate, in part because both were developed with the Web in mind. 
SVG files are vector-based. The name stands for Scalable Vector Graphics. That means rather than recording a pixel-
by-pixel map of an image, SVG files contain formulas that describe the lines, curves, shapes, and other details of an 
image. All modern web browsers support the SVG format, but older browsers’ support for SVG is inconsistent.

If you resize an SVG image when you're working in Animate, it's likely to start looking pixelated—that jagged stair-step 
appearance that graphics get when they're enlarged. When this modified image is viewed in a browser, the pixelation 
shows. It's interesting to note that if you don't change the image within Animate, it resizes gracefully in a browser 
window, when it gets larger and smaller.

Animating text (Video)
Animating text (Video)

Create nested animations with symbols
Create nested animations with independent timelines and interactive capabilities. Symbols are elements that contain 
their own timeline. You can animate a symbol as a regular element on the Stage -- for example, move it from left to right. 
You can also animate the individual elements that make up the symbol. In other words, you can create an animation 
within another animation.

Symbols are reusable and can be controlled with APIs and pre-built code snippets.

http://tv.adobe.com/watch/learn-edge-animate/setting-type-in-motion/
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For a lesson on animating with symbols:

1 Select Window > Lessons in Edge Animate.

2 Click Reuse.

Create a symbol
1 In the Elements panel, select one or more elements. Selecting multiple elements creates a single symbol from them. 

Note: You can also select symbols to create nested symbols.

2 Right-click and select Convert To Symbol from the context menu.

3 In the Create Symbol dialog box, set the Symbol Name, and click OK.

Animate the elements of a symbol
1 In the Elements panel, right-click the symbol and select Edit Symbol. 

You can also right-click the symbol on the Stage.

2 Animate one or more of the elements making up the symbol.

3 To exit symbol editing mode, click the word Stage at the top of the preview window.

4 Preview the animation by clicking the Play button in the Timeline panel or by pressing the Spacebar on the 
keyboard. 

Export a symbol
You can copy and paste a symbol from one project to another.

1 Right-click the symbol in the Elements panel and select Copy.

2 Switch to another project.

3 Right-click the Stage element in the elements Panel and select Paste.

You can also export symbols and their properties as a single file (.easym) that can be shared and imported into another 
composition.

1 Select the symbols to export on the Stage or in the Library panel.

2 Right-click and select Export Symbol.

Import a symbol
1 Click the Plus (+) button next to the Symbols tab in the Library.

2 Browse and select the symbol file (.easym) to import.

Control symbols with JavaScript
You can use JavaScript to control symbols. For more information, see:

• Add interactivity with JavaScript 

• "Working with symbols" in the Edge Animate API guide

http://www.adobe.com/go/animate_api_current
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Learn more
• Leveraging independent symbol timelines

Animate existing HTML
You can animate and add interactivity to elements in existing HTML pages. Because the animation code generated by 
Edge Animate is stored in a separate file, the integrity of the HTML page is preserved.

1 Open an existing HTML page in Edge (File > Open).

Edge Animate only opens standards-compliant code. For example, if you have duplicate IDs, the tool notifies you 
that the document has duplicate IDs and does not open the file. If you receive errors or see odd behaviour, try 
running the HTML page through an HTML validator.

2 Select a page element on the Stage.

You can also select a page element in the Elements panel, which displays the page's DOM (Document Object 
Model).

3 Animate the element. See Using the Pin tool, Keyframes, and Transitions for animation.

Note: There are limitations to what you can do with HTML elements. HTML elements can't be converted to symbols 
and do not have all the properties of other elements. If you receive errors or see odd behaviour, try running the HTML 
page through an HTML validator.

You can also add elements like divs, text, and import images in Edge, and then animate and add interactivity to those 
elements.

Add interactivity with JavaScript
You can use JavaScript to add interactivity to your compositions. You can define actions for each element using a built-
in code editor and snippet library. Actions are functions that can be added to handle a single event.

Define actions
1 On the Timeline, click the Open Actions button on the left side of an element or symbol name. 

http://www.adobe.com/go/learn_edge_animate_symbol_timelines_en
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You can also click the Open Actions button on the left side of an element or symbol name in the Elements panel. 

2 Select an event to trigger the action. 

The Actions Editor appears with a code editor and a list of code snippets on the right. 

3 Write the code for the event.

You can write your own code or use the code snippets to add common functions. For reference information, see the 
Edge Animate API guide.

Use the Code editor
The Code editor gives you a complete view of the JavaScript code in your project. It also allows you to view the raw code 
for the actions file.

1 Select Window > Code.

You can also press Ctrl+E (Windows) or Cmd+E (Macintosh).

2 Select an event or an element by clicking the Plus (+) icon on the left of Stage in the left sidebar. 

3 To edit the entire JavaScript file, click the Full Code button on the upper right of the panel.

Add labels to the Timeline
You can insert labels on the Timeline and then use them as time references in function parameters. You can use a label 
name as a parameter for any playback function expecting a timecode value. Labels let you create actions like playing or 
seeking to a point on the Timeline.

To add a label:

1 Move the Playhead to the location you want.

2 Click the Insert Label button on the upper-right corner of the Timeline.

You can also press Ctrl+L (Windows) or Cmd+L (Macintosh). 

3 Specify a name for the label.

4 When defining an action for an element in the code editor, use the label name as a parameter for playback functions 
expecting a timecode value. 

For example, instead of sym.play(1000), you can use sym.play('mylabel').

http://www.adobe.com/go/animate_api_current
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Add triggers to the Timeline
You can place triggers on the Timeline to execute JavaScript code at a point in time.

To add a trigger:

1 Move the Playhead to the location you want.

2 Click the Insert Trigger button on the upper-right corner of the Timeline.

You can also press Ctrl+T (Windows) or Cmd+T (Macintosh). 

The Code panel appears.

3 Define the action to take at the trigger. For reference information, see the Edge Animate API guide.

You can modify the code for the trigger at any time by double-clicking the trigger icon on the Timeline.

Learn more
• Adding interactivity

• Edge Animate API guide

Leveraging independent symbol timelines (Tutorial)
Leveraging independent symbol timelines (Tutorial)

Create an animated logo (Tutorial)
Create an animated logo (Tutorial)

http://www.adobe.com/go/animate_api_current
http://www.adobe.com/go/learn_edge_animate_interactivity_en
http://www.adobe.com/go/animate_api_current
http://www.adobe.com/go/learn_edge_animate_symbol_timelines_en
http://forums.adobe.com/docs/DOC-2536/
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Chapter 5: Use motion paths

Animating over a curved path

New features summary

New features overview
Sarah Hunt, the Product Manager for Edge Animate provides a brief overview of Edge Animate CC features.

Motion paths
Motion paths allow you to add highly expressive motion to elements which follow along a custom curved path. Using 
this feature, you can emulate real-world experiences through fluid, physics-based movements that cannot be achieved 
through linear motion.

To control the movement of an element using motion paths, perform the following steps:

1 Select the element on Stage, and click Motion Paths in the Contextual Property Panel (CPP) under the Position and 
Size accordion.

Motion Paths option in the Contextual Properties Panel

To set motion paths as the default method of movement for new elements in the composition, select “Animate with 
Motion Paths” from the Layout Defaults.

 

Update to Edge Animate CC available

For more information, see the New features summary .

http://helpx.adobe.com/en/edge-animate/using/whats-new.html
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Using Motion Paths as the default for new elements

2 Create a transition as you normally do using keyframes or the Pin. When you do so, you notice a line drawn between 
two anchor points (represented by triangles) as shown below:

'Bee' element to be moved

Path for the 'Bee' element
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Click the line anywhere to see the handles that you can drag to define the path using a Bezier curve. Use the Auto-
Orient option to control the direction of your object as it moves along the path.

Click the path to see the handles for editing

Motion Path defined using Bezier curve

• To add an anchor point, hover your mouse on the path and click. 

• To delete an anchor point, hover your mouse on the anchor, and then Cmd/Ctrl + Click

• To convert a Bezier to a sharp point, click the anchor point, and then Option/Alt + Click.

• To unlink the two handles on either side of an anchor point so that you can move one independently of the other, 
Option/Alt + click and drag.



58
Use motion paths

Last updated 6/15/2014

Keyframes for location on the timeline represent two separate motion paths. Add a keyframe to split your path into two, 
or delete a keyframe to create one contiguous path. Easing can be applied to motion paths, and the easing effect is 
played back on a per-path basis.

• To split a motion path, add a keyframe in the timeline.

• To create a contiguous motion path, delete a location keyframe on the timeline.

• To split two adjoining motion paths in space, Cmd/Ctrl-click and drag at a joining keyframe anchor.

• To connect two end anchors of separate motion paths, drag the anchors together; they will snap to connect location.

The object is tied to the path by the transform origin. Transform origin can be adjusted so the object can follow the path 
off-center.

 Motion Paths and Responsive Layouts
In the current implementation, motion paths cannot be set to use percentage-based layouts. To work around this, set 
your pathed object inside a group, parent, or symbol and set the parent to use %-based positioning. You can also use 
this method to set the motion path relative to top/right/bottom/left.

Tutorial
Click Windows > Lessons panel, and click Motion Paths for a guided, hands-on exercise on using motion paths in an 
Animate composition.

 Optimized publishing with CDN Hosting
Allow your content to be delivered faster with your runtime files on Adobe Content Deliver Network (CDN). To do so, 
select the Host Runtime Files On Adobe CDN option in the Publish Settings. Your projects download faster with the 
benefit of cache hosting with absolutely no cost to you.

If the content needs to run offline, deselect this option in Publish Settings. This option is enabled by default.

Publishing with CDN hosting

Templates
You can now load, save, and reuse templates from a template gallery. This feature allows you to load an Animate 
composition for common file patterns. Templates can capture images, text, symbols, fonts, and any custom changes in 
your current composition. You can load templates from the visual template loader.
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Access the templates menu from the Welcome screen (“Create from Template”) or from the File menu. From the 
templates gallery you can import, delete, and create a new composition from a template.

Create From Template option in File menu

Template files have .antmpl extension and can be freely distributed and can be stored anywhere on the file system. 

Swipe gestures
You can now bind elements with left and right swiping actions for mobile-focused experiences. You can assign the 
swiping action to any element in your composition. You can assign swipe gestures to the stage itself, or apply to multiple 
elements to create unique mobile experiences.

Right-click the element in the Timeline, click Open Actions For <element> from the menu, and then click swipeleft or 
swiperight.

Swipe gestures
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 Eyedropper tool
The new Eyedropper tool is introduced in the colour selection panels. Select the eyedropper icon to sample colours 
from the stage.

Eyedropper tool

Color coding of elements
You can now assign colors to various elements in your composition to easily identify and work with them. You can click 
the color palette in the Elements panel or Timeline to assign colors. These colors are reflected in the Timeline 
transitions too.

Color coding of elements in Timeline

Color coding in the Elements panel

Elements panel and Timeline jumping
 The elements panel and timeline will now scroll to show selected elements (if the panel is scrolling). 
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New features summary

New features overview
Sarah Hunt, the Product Manager for Edge Animate provides a brief overview of Edge Animate CC features.

Motion paths
Motion paths allow you to add highly expressive motion to elements which follow along a custom curved path. Using 
this feature, you can emulate real-world experiences through fluid, physics-based movements that cannot be achieved 
through linear motion.

To control the movement of an element using motion paths, perform the following steps:

1 Select the element on Stage, and click Motion Paths in the Contextual Property Panel (CPP) under the Position and 
Size accordion.

Motion Paths option in the Contextual Properties Panel

To set motion paths as the default method of movement for new elements in the composition, select “Animate with 
Motion Paths” from the Layout Defaults.

 

Using Motion Paths as the default for new elements

2 Create a transition as you normally do using keyframes or the Pin. When you do so, you notice a line drawn between 
two anchor points (represented by triangles) as shown below:

'Bee' element to be moved

Path for the 'Bee' element

Click the line anywhere to see the handles that you can drag to define the path using a Bezier curve. Use the Auto-
Orient option to control the direction of your object as it moves along the path.

Click the path to see the handles for editing

Update to Edge Animate CC available

For more information, see the New features summary .

http://helpx.adobe.com/en/edge-animate/using/whats-new.html


62
Use motion paths

Last updated 6/15/2014

Motion Path defined using Bezier curve

• To add an anchor point, hover your mouse on the path and click. 

• To delete an anchor point, hover your mouse on the anchor, and then Cmd/Ctrl + Click

• To convert a Bezier to a sharp point, click the anchor point, and then Option/Alt + Click.

• To unlink the two handles on either side of an anchor point so that you can move one independently of the other, 
Option/Alt + click and drag.

Keyframes for location on the timeline represent two separate motion paths. Add a keyframe to split your path into two, 
or delete a keyframe to create one contiguous path. Easing can be applied to motion paths, and the easing effect is 
played back on a per-path basis.

• To split a motion path, add a keyframe in the timeline.

• To create a contiguous motion path, delete a location keyframe on the timeline.

• To split two adjoining motion paths in space, Cmd/Ctrl-click and drag at a joining keyframe anchor.

• To connect two end anchors of separate motion paths, drag the anchors together; they will snap to connect location.

The object is tied to the path by the transform origin. Transform origin can be adjusted so the object can follow the path 
off-center.

 Motion Paths and Responsive Layouts
In the current implementation, motion paths cannot be set to use percentage-based layouts. To work around this, set 
your pathed object inside a group, parent, or symbol and set the parent to use %-based positioning. You can also use 
this method to set the motion path relative to top/right/bottom/left.

Tutorial
Click Windows > Lessons panel, and click Motion Paths for a guided, hands-on exercise on using motion paths in an 
Animate composition.

 Optimized publishing with CDN Hosting
Allow your content to be delivered faster with your runtime files on Adobe Content Deliver Network (CDN). To do so, 
select the Host Runtime Files On Adobe CDN option in the Publish Settings. Your projects download faster with the 
benefit of cache hosting with absolutely no cost to you.

If the content needs to run offline, deselect this option in Publish Settings. This option is enabled by default.

Publishing with CDN hosting

Templates
You can now load, save, and reuse templates from a template gallery. This feature allows you to load an Animate 
composition for common file patterns. Templates can capture images, text, symbols, fonts, and any custom changes in 
your current composition. You can load templates from the visual template loader.

Access the templates menu from the Welcome screen (“Create from Template”) or from the File menu. From the 
templates gallery you can import, delete, and create a new composition from a template.
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Create From Template option in File menu

Template files have .antmpl extension and can be freely distributed and can be stored anywhere on the file system. 

Swipe gestures
You can now bind elements with left and right swiping actions for mobile-focused experiences. You can assign the 
swiping action to any element in your composition. You can assign swipe gestures to the stage itself, or apply to multiple 
elements to create unique mobile experiences.

Right-click the element in the Timeline, click Open Actions For <element> from the menu, and then click swipeleft or 
swiperight.

Swipe gestures

 Eyedropper tool
The new Eyedropper tool is introduced in the colour selection panels. Select the eyedropper icon to sample colours 
from the stage.

Eyedropper tool

Color coding of elements
You can now assign colors to various elements in your composition to easily identify and work with them. You can click 
the color palette in the Elements panel or Timeline to assign colors. These colors are reflected in the Timeline 
transitions too.

Color coding of elements in Timeline

Color coding in the Elements panel

Elements panel and Timeline jumping
 The elements panel and timeline will now scroll to show selected elements (if the panel is scrolling). 

New features summary

Update to Edge Animate CC available

For more information, see the New features summary .

http://helpx.adobe.com/en/edge-animate/using/whats-new.html
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New features overview
Sarah Hunt, the Product Manager for Edge Animate provides a brief overview of Edge Animate CC features.

Motion paths
Motion paths allow you to add highly expressive motion to elements which follow along a custom curved path. Using 
this feature, you can emulate real-world experiences through fluid, physics-based movements that cannot be achieved 
through linear motion.

To control the movement of an element using motion paths, perform the following steps:

1 Select the element on Stage, and click Motion Paths in the Contextual Property Panel (CPP) under the Position and 
Size accordion.

Motion Paths option in the Contextual Properties Panel

To set motion paths as the default method of movement for new elements in the composition, select “Animate with 
Motion Paths” from the Layout Defaults.

 

Using Motion Paths as the default for new elements

2 Create a transition as you normally do using keyframes or the Pin. When you do so, you notice a line drawn between 
two anchor points (represented by triangles) as shown below:

'Bee' element to be moved

Path for the 'Bee' element

Click the line anywhere to see the handles that you can drag to define the path using a Bezier curve. Use the Auto-
Orient option to control the direction of your object as it moves along the path.

Click the path to see the handles for editing

Motion Path defined using Bezier curve

• To add an anchor point, hover your mouse on the path and click. 

• To delete an anchor point, hover your mouse on the anchor, and then Cmd/Ctrl + Click

• To convert a Bezier to a sharp point, click the anchor point, and then Option/Alt + Click.
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• To unlink the two handles on either side of an anchor point so that you can move one independently of the other, 
Option/Alt + click and drag.

Keyframes for location on the timeline represent two separate motion paths. Add a keyframe to split your path into two, 
or delete a keyframe to create one contiguous path. Easing can be applied to motion paths, and the easing effect is 
played back on a per-path basis.

• To split a motion path, add a keyframe in the timeline.

• To create a contiguous motion path, delete a location keyframe on the timeline.

• To split two adjoining motion paths in space, Cmd/Ctrl-click and drag at a joining keyframe anchor.

• To connect two end anchors of separate motion paths, drag the anchors together; they will snap to connect location.

The object is tied to the path by the transform origin. Transform origin can be adjusted so the object can follow the path 
off-center.

 Motion Paths and Responsive Layouts
In the current implementation, motion paths cannot be set to use percentage-based layouts. To work around this, set 
your pathed object inside a group, parent, or symbol and set the parent to use %-based positioning. You can also use 
this method to set the motion path relative to top/right/bottom/left.

Tutorial
Click Windows > Lessons panel, and click Motion Paths for a guided, hands-on exercise on using motion paths in an 
Animate composition.

 Optimized publishing with CDN Hosting
Allow your content to be delivered faster with your runtime files on Adobe Content Deliver Network (CDN). To do so, 
select the Host Runtime Files On Adobe CDN option in the Publish Settings. Your projects download faster with the 
benefit of cache hosting with absolutely no cost to you.

If the content needs to run offline, deselect this option in Publish Settings. This option is enabled by default.

Publishing with CDN hosting

Templates
You can now load, save, and reuse templates from a template gallery. This feature allows you to load an Animate 
composition for common file patterns. Templates can capture images, text, symbols, fonts, and any custom changes in 
your current composition. You can load templates from the visual template loader.

Access the templates menu from the Welcome screen (“Create from Template”) or from the File menu. From the 
templates gallery you can import, delete, and create a new composition from a template.

Create From Template option in File menu

Template files have .antmpl extension and can be freely distributed and can be stored anywhere on the file system. 
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Swipe gestures
You can now bind elements with left and right swiping actions for mobile-focused experiences. You can assign the 
swiping action to any element in your composition. You can assign swipe gestures to the stage itself, or apply to multiple 
elements to create unique mobile experiences.

Right-click the element in the Timeline, click Open Actions For <element> from the menu, and then click swipeleft or 
swiperight.

Swipe gestures

 Eyedropper tool
The new Eyedropper tool is introduced in the colour selection panels. Select the eyedropper icon to sample colours 
from the stage.

Eyedropper tool

Color coding of elements
You can now assign colors to various elements in your composition to easily identify and work with them. You can click 
the color palette in the Elements panel or Timeline to assign colors. These colors are reflected in the Timeline 
transitions too.

Color coding of elements in Timeline

Color coding in the Elements panel

Elements panel and Timeline jumping
 The elements panel and timeline will now scroll to show selected elements (if the panel is scrolling). 

Publish your content
To publish your content:

1 Specify your publish settings. See below for more information.

2 Select File > Publish.

Optimize content for the web
1 Select File > Publish Settings.

2 In the Publish Settings dialog box, make sure that Web is selected as the publish target.

3 Note or change the target directory.
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4 Set the Frameworks Via CDN preference. 

Select this option to download the composition's associated jQuery assets from a content delivery network (CDN). 
Leave the option deselected to package the assets with the composition.

5 Set the Publish Content As Static HTML preference. 

Select this option to generate HTML markup instead of injecting Edge Animate content into the document through 
JavaScript. This option improves SEO-friendliness and accessibility on some platforms.

6 Click Save to save the publish settings, or click Publish.

Publish as Animate Deployment Package (.oam)
Select this export option to create a package file of your project for use in other Adobe tools. The following tools support 
Animate Deployment Packages: Adobe Digital Publishing Suite (DPS), InDesign CS6, Dreamweaver CS6, and Muse.

1 Select File > Publish Settings.

2 In the Publish Settings dialog box, make sure Animate Deployment Package is selected as the publish target.

3 Note or change the target directory.

4 (Optional) Specify a poster image.

5 Click Save to save the publish settings, or click Publish.

Publish to Apple iBooks Author
1 Select File > Publish Settings.

2 In the Publish Settings dialog box, make sure iBooks/OS X is selected as the publish target.

3 Note or change the target directory.

4 (Optional) Specify a poster image. 

5 Click Save to save the publish settings, or click Publish.

Learn more
• Enhance your DPS folios with HTML animations using Adobe Edge

What's new in Edge Animate 1.5
Important: Edge Animate 1.5 is no longer supported by Adobe and is not recommended for production use. This 
version lacks major features, such as motion paths and audio support, introduced in newer releases, as well as 
performance enhancements and bug fixes (including compatibility issues with modern browsers that can result in 
unexpected output rendering).

Add gradients to objects
The gradient panel introduced in this release allows you to add gradients to Edge Animate elements. You can create 
both linear and radial gradients using the options in the panel.

Gradients can be animated. However, you cannot animate between a radial gradient and a linear gradient.

Video tutorial

http://www.adobe.com/go/learn_edge_animate_dps_en
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Applying colors and gradients in Edge Animate

You can do the following in the gradients panel:

• Use color stops to create complex gradients.

• Create linear gradients or radial gradients.

• For linear gradients, specify the angle of the gradient.

• Save custom gradients as swatches.

• Specify a value for color in any of the three formats (RGBa, Hexadecimal, or HSLa). The "a" refers to the alpha value 
or the opacity value. Irrespective of the format you use to define color, Animate ultimately converts the values to 
RGB format.

• To apply CSS properties to the radial gradient such as Ellipse-farthest-corner, Circle-farthest-side, and so on, click 
and hold the Radial Gradient button. Select the option that you want to apply.

Note: Gradients are not supported in Internet Explorer version 9. Any applied gradients are replaced with the background 
color.

A Remove color  B Angle for linear gradient  C Linear gradient swatch  D Radial gradient swatch  E Color stop  F Add gradient swatch  G Repeat 
pattern  H Color format buttons  I Lightness slider  J Color slider  K Opacity slider  L Add color swatch  M Color swatch  N Selected color  
O Original color  P Radial gradient button  Q Gradient button  R Linear gradient button  

For a video tutorial on using colors and gradients in Edge Animate, click here.

Updates to the color panel
In the color panel, you can now do the following:

• Use the Lightness bar slider to customize the intensity for a selected color.

• Use the Opacity bar slider to specify the opacity (transparency) for the selected color.

https://helpx.adobe.com/creative-cloud/tutorials/videos/edge-animate-colors-gradients.html?product=animate&path=fundamentals
https://helpx.adobe.com/creative-cloud/tutorials/videos/edge-animate-colors-gradients.html?product=animate&path=fundamentals
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• Save the custom colors as swatches for reuse.

• Specify a value for color in any of the three formats (RGBa, Hexadecimal, or HSLa). The a refers to the alpha value 
or the opacity value. Irrespective of the format you use to define color, Animate ultimately converts the values to 
RGB format.

A Option to enter color code  B Color button  C Option to remove color  D Added color swatch  E Option to add color swatch  F Slider for opacity  
G Slider for color lightness  H Slider for color  I Color code format options  

Using CSS filters
Options in the Filters panel help you quickly apply CSS filters to symbols, text, Divs, and images. The only way you 
could previously apply such effects was using an image editor.

CSS filters are currently supported on the latest versions of Chrome, Safari, iOS6, and Blackberry 10.

To apply a CSS filter, select an object on the stage, and use the options in the Filters panel to apply the desired effects. 
For example, to apply filters to an inserted image, select the image, and apply filters as required. 

To remove a filter from the element, click the corresponding "x" button.

For a video tutorial on using CSS filters in Edge Animate, click here.

https://helpx.adobe.com/creative-cloud/tutorials/videos/edge-animate-css-filters.html?product=animate&path=fundamentals
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Leverage Edge web fonts for better typography
Edge Animate helps leverage the power of the @font-face CSS property by providing you with an array of web fonts for 
your design. Edge web fonts allow you to bring the typographic experience of the print medium to the web.

Edge Web Fonts features hundreds of web fonts from the Adobe library as well as a large collection of open source fonts. 
Edge Web fonts are free and require no account or kit configuration — making it faster and easier to get started. 

Using Edge Web fonts in Edge Animate
When applying font to Text, click the "+" button next to the Font menu to view the Edge Web Font dialog. Select the 
font that you want to use from the list and click Add Font.

You can filter the fonts in the panel by their type using the buttons to the left of the panel. For example, to view only 
fonts of the sans serif type, click the Sans Serif button. For more information, see Use Web Fonts .

Video tutorial

Using Web fonts in Edge Animate

The selected and applied fonts are added to the Font library in Edge Animate. Double-click the font in the Font library 
to specify fallback fonts. If the selected font, for some reason, cannot be applied, the fallback fonts are used based on 
the order in which they are listed.

http://helpx.adobe.com/en/edge-animate/using/web-fonts.html#main-pars_text
https://helpx.adobe.com/creative-cloud/tutorials/videos/edge-animate-web-fonts.html?product=animate&path=fundamentals
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Iframe friendly preloaders
Preloading is now optimized to work within Iframes for coordinated resource loading. Animate compositions 
contained within Iframes wait for the document to load before playing the file. 

Iframe preloaders allow you to preload the Iframe with an advertisement before the Animate file and the web page are 
downloaded.

For more information on using preloaders, see Adobe Edge Animate JavaScript APIs.

Symbol editing mode preserved during Preview
Animate preserves your current editing state on each preview. The composition does not return to the stage when 
previewing in a browser.

Easily identify locked and unlocked elements
Locked elements appear dimmed on the Timeline and the Elements panel allowing you to easily distinguish them from 
unlocked elements.

In-app lessons
The Lessons panel in Adobe Edge Animate provides hands-on tutorials with sample assets that you can follow within 
the tool.

http://www.adobe.com/devnet-docs/edgeanimate/api/current/index.html#coordinatedpreloading
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Lessons panel

You can access the Lessons panel from the Getting Started tab on the Welcome Screen, or from the Window menu 
(Window > Lessons).

Lessons

Target older browsers
Adobe Edge Animate uses web-standards such as HTML5, CSS3, and JavaScript to define animation and interactivity. 
Some functionality may not work or appear in older browsers that don't support these standards. You can still target 
older browsers by creating poster images. You can also use the Google Chrome Frame extension for Internet Explorer 
for Windows users.
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Support older browsers with poster images
Define a fallback state of your project in the form of a poster image or of your own artwork. When visitors view your 
content in a legacy web browser, the poster image is displayed.

1 In the Timeline panel, position the Playhead at the end state of all animations.

2 In the Elements panel, select the Stage element.

3 In the Properties panel, click the Capture Stage As Poster Image button (camera icon).

4 In the Capture a Poster Image dialog box that appears, click Capture.

5 In the Properties panel, click the Edit button for the Down-level Stage property.

6 Click the Insert button. The image that you captured appears on the down-level stage.

To use your own artwork, drag the image from the Library panel to the down-level stage.

7 Return to the main stage by clicking the Stage breadcrumb at the top of the preview window.

Support older browsers with Google Chrome Frame
Google Chrome Frame is an extension that can be installed in older versions of Internet Explorer. It enables HTML5 
technologies such as those used by Edge Animate.

1 Select File > Publish Settings.

2 In the Publish Settings dialog box, make sure that Web is selected as the publish target.

3 Select the Use Google Frame for IE 6, 7, and 8 option.

4 Accept the default Chrome Frame Installer "No Prompt" option.

5 Click Save to save the publish settings and return to the composition.

See also Enable open web technologies in Internet Explorer on the Google Developers website.

System requirements for Animate
System requirements for Animate

https://developers.google.com/chrome/chrome-frame/
http://helpx.adobe.com/x-productkb/policy-pricing/system-requirements-animate.html
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Release Notes
Edge Animate CC 4.0 (June 2014) Release Notes 

Edge Animate CC 3.0 (January 2014) Release Notes 

Edge Animate 1.5 Release Notes

Learn Edge Animate video tutorials
Learn how to do the basics of Edge Animate CS6 with Getting Started and New Features tutorials by product experts. 

Learn Edge Animate video tutorials

Create your first Edge Animate project
There are two ways in which we can create a new Edge Animate project. The first option is to simply click on Create 
New on the welcome screen. This will immediately create a new Edge Animate project with a blank stage. The second 
method of creating a new Edge Animate project is through the file menu. Simply clicking on File and then on New will 
have the exactly same effect.

Alternatively, we can use the keyboard shortcut: Ctrl + N (for Windows) or Command + N (for Mac). 

Whichever method you choose, you will now have a new project opened within Edge Animate. This project will look 
quite scarce to begin with, as it basically consists of a single, blank Stage symbol. This Stage is representative of the single 
HTML element we can locate within the HTML file Edge Animate produces upon saving it, as shown in the following 
screenshot:

http://helpx.adobe.com/en/edge-animate/release-note/cc-version-2014.html
http://helpx.adobe.com/en/edge-animate/release-note/release-notes-edge-animate.html
http://helpx.adobe.com/edge-animate/release-note/release-notes-edge-animate.html
http://tv.adobe.com/show/learn-edge-animate/
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Save

This option will either save the current document if it has been previously saved to the file system, or it will prompt the 
user to provide a file name and location to save the document if this happens to be a new project.

The keyboard shortcut for this option is Ctrl + S (for Windows) or Command + S (for Mac). 

Save As…

Similar to the Save option, this provides the same functionality but will always prompt the user for a file name and 
location through a system dialog. This is useful when saving separate versions of the same project, or when you simply 
want to save the project to a new location.

The keyboard shortcut for this option is Ctrl + Shift + S (for Windows) or Command + Shift + S (for Mac). 

In the case of a new project, either option will provide us with a file system dialog. We see from the previous screenshot 
that what we are saving is, in actuality, a .html file. This is an important thing to remember about Edge Animate 
projects—when we are working in the Edge Animate authoring environment, we are really working in real time with 
the content that is being produced.
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Layout and guidance tools
When working with any element on Stage, it is useful to have some tools which assist in the layout and positioning of 
the elements in question. Edge Animate comes equipped with a number of tools which assist us in this task—Layout 
Preferences tool, Rulers, and Guides.

Layout Preferences tool
The Layout Preferences tool allows us to make some decisions around the default properties of certain element types 
when create or imported. The tool itself is located on the toolbar, to the right-hand side of the default color swatches. 
It appears as a small ruler in the toolbar, indicating layout:

When this tool is activated, a small overlay appears which allows us to set a number of layout preferences for the current 
project. Most of these preferences have to do with how elements are measured; using either pixels or percentage units:

These choices only affect anything new that is created in our composition or newly imported to it. Currently established 
elements retain their settings.

The following table details the choices we have when determining layout preferences for an Edge Animate composition. 
The units for horizontal, vertical, width, and height, though appear to have the same description, are distinct values and 
it is clear when you adjust these parameters on Stage.

Rulers
When enabled, Rulers are set along the top and left-hand side axis of project stage in a similar fashion to other Adobe 
creative applications. They assist in visualizing the measurements between elements, the relation to Stage registration 
point, element alignment, and more.

Preference Description

Corner Alignment It selects which corner to align to by default. 

Horizontal Position Units These toggle between pixels and percentage for new elements. 

Vertical Position Units These toggle between pixels and percentage for new elements. 

Width Units These toggle between pixels and percentage for new elements. 

Height Units These toggle between pixels and percentage for new elements. 

Use 'img' tag for images When importing images, use the img tag type. 

'auto' for image width When importing images, set width to auto. 

'auto' for image height When importing images, set height to auto. 
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Rulers also serve with the generation and positioning of manual Guides, which we will examine in the next section.

Note: To toggle rulers on and off, choose the Rulers option from the View menu in the application, or use the keyboard 
shortcuts: Ctrl + R (for Windows) and Command + R (for Mac).

Guides
Guides are used alongside Rulers in order to more precisely plot out and position elements on Stage. They can also be 
used to scope out areas in which we can draw elements using tools such as the Rectangle tool or the Rounded 
Rectangle tool:

To create new Guide, be sure for Rulers been activated and are visible within the Stage panel. Click upon a ruler and 
drag new Guide out along that specific axis. Once Guide is positioned exactly where we like, release the mouse to drop 
Guide in place.
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Once Guide has been placed, it can remain a pixel-based Guide or transformed into a percentage-based Guide to assist 
with responsive layout tools. To convert Guide from pixel units to percentages, hover over Guide and right-click. We 
now have the option Convert Guide to Percentage. Guide will now appear in a more teal color than the normal violet 
to distinguish it from pixel-based Guide. Resizing Stage will shift Guide as well—as it is now positioned based upon 
percentage and not absolute pixel units.

To remove Guide, simply click upon it and drag it back into Ruler. Guides can be locked from the View area of the 
application menu. Snapping can also be controlled from the View menu.

Smart Guides
When Smart Guides are enabled, dragging elements around Stage will cause temporary guides to appear which can 
assist with placement of elements. These guides will appear in alignment of other elements, or in order to align with 
aspects of Stage itself. For instance, in the following screenshot, Smart Guides appear when an element is dragged to 
the center of Stage, informing us that we will be able to center the object if dropped upon this location.

Smart Guides can be disabled from the application menu under View | Smart Guides. Keyboard shortcut: Ctrl + U 
(for Windows) and Command + U (for Mac).

Importing external assets
Apart from the creation of basic vector and text elements within an Edge Animate composition, we also have the ability 
to import external assets for use in a project. These assets may have been prepared in another application such as Adobe 
Photoshop, Illustrator, or Fireworks. Generally, we would want to use these imported assets more than the simple 
shapes generated by Edge Animate, but this will depend upon the project. File types which can be imported into Edge 
Animate include:

• SVG: Scalable Vector Graphics

• PNG: Portable Network Graphics

• JPEG: Joint Photographic Experts Group
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• GIF: Graphics Interchange Format

Importing bitmap images
Once an image file is imported into an Edge Animate project, it can be manipulated, animated, and scripted just as any 
other element. To import a bitmap image file into Edge Animate, we perform the following actions:

1 Navigate to the Edge Animate application menu.

2 Select File | Import….

3 A system file browser dialog will appear. Navigate to the .png, .gif, or .jpg file you wish to import.

4 Select the file and click on Open.

5 The file will now be placed onto the Stage and also added to the project Library under Assets. From here, we can 
add multiple instances of this asset to the Stage. 

Note: Note that similar to SVG files, the bitmap file instance placed upon the Stage will be using the exact dimensions of 
the imported file itself, so it may overlap the boundaries of the Stage. This can be remedied through element manipulation 
by using the Properties panel.

Now that the bitmap image asset has been imported and an instance of this asset resides upon the Stage, we can use the 
Selection and Transform tools to perform manipulations such as resize, scale, and skew just as we can with text or 
rectangle elements. Unlike vector-based elements, however, visible artifacting, blockiness, and other distortions will 
occur with bitmap objects.

It is also possible to simply drag-and-drop a .jpg, .png, or .gif file from our operating system file explorer onto the Stage. 
This action will have the same effect as described above when working through the application's Import… command, 

but we will be able to precisely place the imported image onto the Stage when employing drag-and-drop.
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Animation within Edge Animate
There are many applications which enable the user to compose animated sequences. Users of Adobe Edge Animate may 
have experience in other programs such as Director, Flash Professional, After Effects, or even Photoshop. All of these 
applications handle animation in slightly different ways, but they do all share some aspects of animation techniques and 
tooling in common as well.

Like many digital animation programs, Edge Animate employs the concept of "tweening" between keyframes. In 
traditional cell-based animation, a master animator would draw out certain key frames for an animation sequence, and 
the frames in between these key frames would be created by apprentice or lower-ranked members of the animation 
team. The goal was always to create a smooth transition between each key frame created by the master animator, which 
would result in a completed animation sequence.

This process is performed programmatically within Edge Animate. As keyframes are placed along the Timeline, Edge 
Animate will record changes in property values as transitions at the position of the Playhead (moment in time). As 
authors, we have the additional ability to provide the tweening engine with instruction sets based upon a variety of 
easing equations. This allows a more natural flow between keyframes, and can also be used to achieved certain effects 
such as an elastic or bounce motion.

The Edge Animate Timeline
The Timeline is where all of the motion in an Edge Animate composition is orchestrated. The Timeline itself shares 
concepts and constructs from other Adobe applications, most notably Flash Professional and After Effects.

Note: Unlike the frame-based timeline in Flash Professional, the Edge Animate Timeline is purely time-based.

Playback controls
The playback controls in Edge Animate are all grouped together in the upper-left corner or the Timeline panel. These 
controls allow quick access to many of the playback options available through the Timeline.

Time
The time in Edge Animate is measured in standard decimal time code format (mm:ss.ddd), and this is how it is 
displayed in the Time control. As the Playhead moves along the Timeline, the information in this display is updated 
accordingly. A user can scrub the control to the left or right to adjust the current time, or simply click on it—making it 
editable.
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Note that the time controls in Edge Animate are actually grouped along with the Stage and are accessible from directly 
beneath that panel. The controls are also broken up to allow separate modification of the Playhead time (yellow), and 
Pin time (blue), when enabled.

Timeline options
These options can be toggled on or off depending upon current needs as they perform a variety of Timeline-related 
functions.

These options include the following:

• Auto-Keyframe Mode (K): Selecting this option will enable Edge Animate to generate keyframes for various 
properties automatically as they are adjusted along the Timeline. When not selected, any keyframes must be inserted 
manually.

• Auto-Transition Mode (X): When enabled, this informs Edge Animate to use immediate transitions between 
element property adjustments as they are animated across time.

• Toggle Pin (P): Toggles the Pin on and off. We'll discuss the Pin in more detail shortly.

There are also a number of options present on the bottom of the Timeline:

• Only Show Animated Elements: When this option is selected, only those elements whose properties are animated 
will display within the Timeline. Static elements (such as a background image, perhaps) will be hidden.

• Timeline Snapping: Toggles Timeline snapping on or off.

• Show Grid: Toggles Timeline grid on or off and allows us to set the grid spacing units.

More about the Show Grid control
We are also able to set the grid spacing by clicking on the small arrow to the immediate right of this icon in order to 
access a small list of options. We can choose to display grid lines over a selection of measurements across the Timeline.
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Timeline controls
There are basically only four controls within the Timeline that we need to be concerned with: the Playhead, the Pin, 
Zoom, and a set of Grid controls. The functionality between controls varies greatly here, as some are used for playback, 
some for animation, and others are simply there for the enhancement of our overall workflow. All, however, are very 
useful.

The Playhead
The Playhead is the larger of the two elements on the Timeline and is represented by a solid red line which indicates 
the current time. We can click on the Playhead and scrub back and forth to change the current time. When an 
animation is being played back through Edge Animate, the Playhead will move along with the current time.

Note: Normally, the Playhead and the Pin are both synced. If not, they can be resynced through the application menu: 
Timeline | Toggle Pin.

The Pin
The Pin is a unique control to Edge Animate. It is a way of pinning the current state of element properties to a certain 
time, while using the Playhead to determine at which time the animation should complete. The Pin can be positioned 
either before or after the time indicated by the Playhead—but it always indicates a starting point for the animation, with 
the Playhead indicating the end. Changing any element properties while the Pin is unsynced will create animation of 
those properties beginning at the Pin and ending at the Playhead position. In this way, we can quickly and freely create 
animation that is tightly controlled across the Timeline.

To quickly sync or unsync the Pin from the Playhead, we can double-click on the Playhead to toggle between each state. 
We can also use the keyboard shortcut (P) to accomplish this same task—or even use the control in the Timeline which 

performs this action.

When the Pin has been activated, the direction of animation is indicated through a colored strip of chevrons on the 
Timeline. The color will be yellow or blue, depending upon the direction of motion; blue indicates motion to the left of 
the Pin, while yellow indicates motion to the right of the Pin.

Zoom controls
There are two zoom controls in Edge Animate which allow us to expand and contract the Timeline. One is the Zoom 
Timeline to Fit button that appears as dual arrows in the lower-right corner of the Timeline. This will expand or contract 
the entire span of the visible Timeline to the current width of the Timeline panel. It can provide a good overview of the 
entire animation.

The second control is a slider which appears directly to the right and allows the user to manually control the zoom level 
of the Timeline to accommodate whatever we are specifically trying to accomplish at any particular time. 
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Keyframes
Similar to their representation in After Effects, keyframes in Edge Animate appear along the Timeline as small 
diamonds. Unlike keyframes in Flash Professional, Edge Animate keyframes are tied directly to the property that is 
being changed and not to the element itself. This allows for fine-grained property adjustments across the Timeline for 
any particular element. It is very flexible and a powerful way to animate selected element properties!

Keyframe navigation
There are a number of keyboard shortcuts in Edge Animate that assist with Timeline navigation—specifically when 
jumping across keyframes.

Creating motion
Animating element properties within Edge Animate is fairly straightforward. In this section, we're going to step 
through a number of basic ways to animate elements along the Edge Animate Timeline. Once using only the Playhead, 
and again using the Playhead in conjunction with the Pin. By performing the same animation in each way, we will get 
a feel for the different workflow styles Edge Animate makes available to us when animating element properties across 
time.

Note: Note that most elements will not appear within the Timeline until their properties are actually modified across time. 
The reasoning for this is if nothing is actually animated, there is no reason to clutter the Timeline.

Inserting keyframes
There are a number of mechanisms through which we can insert keyframes into our composition; using the Properties 
panel, the application menu, the Timeline Keyframe buttons, or through the right-click menu. Before we move on, let's 
have a quick look at each of these methods.

Adding keyframes through the Properties panel
With any element selected, we can position the Playhead upon the Timeline and look to the Properties panel to insert 
our keyframes. Notice how most of the property values have a small diamond next to them? By clicking on this 
keyframe control, we will manually insert a keyframe for that property into the current Playhead position for the 
selected element.

Command Shortcut

Go to Previous Keyframe Ctrl + Left Arrow (Windows), Command + Left Arrow (Mac) 

Go to Next Keyframe Ctrl + Right Arrow (Windows), Command + Right Arrow (Mac) 
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Adding keyframes through the application menu
With any element selected, we can position the Playhead upon the Timeline and look to the application menu to insert 
our keyframes. Simply navigate to the menu and choose Timeline | Add Keyframe and then select the type of keyframe 
to add, based upon the property we wish to set a keyframe for.

Not all properties have keyboard shortcuts assigned to them by default, though we can easily assign them for commonly 
used properties, if we wish. This is accomplished through the application menu: Edit | Keyboard Shortcuts….

Using the Timeline keyframe buttons
With any element selected, we can position the Playhead upon the Timeline and look to the left area of the Timeline 
panel to insert our keyframes. Any property which currently has a keyframe assigned to it will appear grouped beneath 
an element in the Timeline. These existing properties will include a small icon positioned to the right of the property 
name through which we can add new keyframes for that specific property.

To add new keyframes to properties which do not appear beneath an element, we can simply right-click on the element 
name and choose Add Keyframe to insert them. 
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Using right-click for Keyframe insertion
With any element selected, we can position the Playhead upon the Timeline and look to the Stage itself to insert our 
keyframes. Simply right-click on any element which exists on the Stage at that place in the Timeline, and choose Add 
Keyframe to insert any of the available properties for that element.

Animating with the Playhead
We will now do a simple animation of an element moving from one side of the Stage to the other, while rotating and 
changing color using the Playhead along with the Properties panel.

1 Create a new Edge Animate project and save it to your local disk.

2 Adjust the Stage as follows by using the Properties panel:

• Stage W: 600 px

• Stage H: 350 px
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• Background Color: #000000

• Overflow: hidden

3 Using the Rectangle tool, draw out an element upon the Stage. We will modify its properties in the next step, so do 
not worry about dimensions or shape.

4 For each property listed, make the following adjustments within the Properties panel:

• Location X: 20 px

• Location Y: 230 px

• Size W: 100 px

• Size H: 100 px

• Background Color: #c0c0c0

5 Still using the Properties panel, click on the keyframe diamond next to the properties for Location, Background 
Color, and Rotation. This will set a keyframe for each property within the Timeline.

6 Be sure that Auto-Keyframe properties is in its selected state in the Timeline. Since we have already marked each of 
these properties with initial keyframes, any adjustments we make across time will be auto-keyframed.

7 Our project should now appear as shown in the following screenshot. We are ready to proceed with the remainder 
of this exercise.

8 Drag the Playhead over to the ruler marker labeled 0:04 and release.

9 Now, select the element with the Selection tool and in the Properties panel, modify the following properties:

• Location X: 480 px

• Background Color: #900000

• Rotation: 480 deg
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10 Notice that we now have transition bars appear on the Timeline with another set of keyframes at the end of our 
animation sequence.

11 We can now either scrub through the Timeline by dragging the Playhead back and forth, or hit the Play button to 
view the full sequence. When played back, the element should appear to roll along the Stage from left to right, 
changing from gray to red as it does so. The resulting end state is displayed in the following screenshot:

Note: Note that any of the properties of an element can be keyframed, thus modified over time in the way we have done 
here.

Animating with the Pin
Now we will perform the preceding exercise, but this time we will employ the Pin to demonstrate an alternate way of 
creating motion in Edge Animate.

1 Create a new Edge Animate project and save it to your local disk.

2 Adjust the Stage as follows by using the Properties panel:

• Stage W: 600 px

• Stage H: 350 px

• Background Color: #000000

• Overflow: hidden

3 Using the Rectangle tool, draw out an element upon the Stage. We will modify its properties in the next step, so do 
not worry about dimensions or shape.

4 For each property listed, make the following adjustments within the Properties panel:

• Location X: 20 px
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• Location Y: 230 px

• Size W: 100 px

• Size H: 100 px

• Background Color: #c0c0c0

5 Drag the Playhead to 0:04 in the Timeline. 

6 Now, go to the application menu and select Timeline | Toggle Pin. This will unsync the Pin from the Playhead. 
Again, the Pin is the small control directly beneath the Playhead when unsynced.

7 Grab the Pin and drag it to 0:00 in the Timeline. This will pin the elements current properties to the 0:00 point 
without the need to manually insert keyframes. Keep the Playhead itself at 0:04.

8 Now, select the element with the Selection tool and in the Properties panel, modify the following properties:

• Location X: 480 px

• Background Color: #900000

• Rotation: 480 deg

Notice that we now have transition bars appear on the Timeline without the need to set any keyframes whatsoever.

9 Go to the application menu and select Timeline | Toggle Pin to sync the Pin. We can also toggle the Pin through a 
keyboard shortcut as expressed earlier in this chapter.

10 We can now either scrub through the Timeline by dragging the Playhead back and forth, or hit the Play button to 
view the full sequence. When played back, the element should appear to roll along the Stage from left to right, 
changing from gray to red as it does so.

Note: Note that, while in this case the Pin was placed at an earlier time in relation to the Playhead within our Timeline—
that need not be the case. We can also place the Pin at a later time than the Playhead and the same behavior will be 
exhibited: current properties are pinned to the Pin position while adjusted properties align to the position of the 
Playhead.

Editing transitions
Once a transition has been established, it can be adjusted through mouse interaction via the Timeline. In order to adjust 
the transition delay, duration, and end we simply click-and-drag the visual transition indicators within the Timeline 
itself.
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Note: Note that transitions can be adjusted on a per-object or per-property basis, allowing for a great amount of freedom 
when defining motion behavior.

Transition delay
This determines when the transition should begin, measured from the start of the overall Timeline. Modification of this 
value is accomplished by either moving the entire transition, or by dragging the right-most edge.

Transition duration
This represents the time taken up by the entire transition. Transitions can be extended or shortened easily by dragging 
the right-most edge.

Transition end
This is the time with which the transition completes within the Timeline.

Modifying element properties based on transition
To select a transition to edit element properties within the Properties panel; use the mouse to select a Transition block 
within the Timeline. The cursor should change to a little grabby hand and clicking on the transition will cause it, along 
with any of its keyframes, to highlight.

We now know that the element is selected and can see that the Properties panel adjusts to reflect the properties of that 
element at the position of the Playhead. To adjust any properties across time, simply move the Playhead to see the 
Properties panel adjust to these changes.

Note: Note that when changing the easing behavior of a transition, we can select the entire element transition block or we 
may choose individual property transitions to apply a variety of transition types to the same element. It is quite flexible.
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Transition easing controls
You may have noticed that the motion achieved through the examples presented so far have been plain, linear 
transitions from one value to another. To provide a greater sense of realism and a fuller, dynamic nature to individual 
transitions, we also have the ability to assign a variety of easing equations to our transitions. 

There are many easing choices within Adobe Edge Animate. The default is Linear, which will simply express a transition 
from A to B in an entirely linear fashion. Often, an easing algorithm of a more dynamic nature is required to express a 
bit more realism in motion, or to achieve a specific effect. Edge Animate comes bundled with no less than 32 easing 
choices to provide the user with a variety of options when determining transition easing.

Note: The transition easing algorithms available in Edge Animate are similar to others found in many ActionScript 
libraries for animating Flash Professional content. Unlike in Flash Professional, Edge Animate does not yet have the ability 
to customize these presets.

Transition easing types
While Edge Animate does supply us with a large number of easing types, exactly what they do may not be obvious to 
many users at first glance. It is very simple to set up an Edge Animate project that allows us to adjust and visualize each 
of these easing types when applied to a simple transition.

Note: Almost all easing types have three variants of themselves, ease in, ease out, and both ease in and ease out together.

Shifting transitions
Edge Animate makes it very easy to shift transitions back and forth across the Timeline. Simply use the mouse cursor 
to grab a transition (click and hold) and then move the mouse back and forth along the Timeline until the transition 
appears at the desired location. Release the mouse to complete the shift.

Changing transition duration
To adjust the duration of any transition, simply hover the mouse cursor over the beginning or end of any transition 
block until the cursor changes to indicate that adjustments are possible. Then, click-and-drag along the Timeline to 
adjust the length of a particular transition. We can also select multiple Transitions in this same way through use of the 
Shift key while we make additional selections along the Timeline.
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The cursor will adjust to look like two lines with arrows pointing to the left or right when hovering over a transition we 
can expand in this manner.

Selecting transition keyframes
To select individual keyframes, simply click on the desired keyframe and perform whatever modification is desired. 
Some possible options include hitting the Delete key on the keyboard to remove the selected keyframes, or modifying 
the transition through the right-click menu.

The cursor will adjust to look like a small pointing hand if we are able to select a keyframe. Of course, any locked 
element keyframes cannot be interacted with in any manner.

Selecting multiple transitions
Holding the Shift key down while keyframes are selected will enable the selection of multiple keyframes. Alternatively, 
a selection rectangle can be drawn across multiple keyframes, but this is imprecise, as full transitions will more than 
likely be selected as well.

Copy and paste keyframes
While keyframes are selected, we can easily copy and paste these keyframes from one spot in the Timeline to another 
by moving the Playhead to another position before we paste. This is a good mechanism for copying the exact properties 
we want and replicating them across the Timeline.

Generating transitions through keyframes
With multiple keyframes selected, we can choose to right-click on them in order to remove or create transitions 
between them. This is useful when we have used auto-transition mode but then decide to retain keyframes but remove 
the smooth transition between them, or perform the reverse intention.
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Animating a website header
One of the basic use cases for Adobe Edge Animate is the creation of a simply animated website header. We will be 
authoring such a composition for a studio recording project of the name An Early Morning Letter, Displaced, who wish 
to have images of each of their releases animate in on the header itself. Thankfully, they have provided us with all of the 
assets necessary for the construction of this animated header.

Note: These assets are included as part of the files for this chapter and are in the folder named banner_assets.

Project setup, asset import, and general layout
The first step in this composition will be to set up our Edge Animate project, import all of the assets, and arrange them 
upon the Stage. We will begin by arranging the assets in their final form, as they should appear at the end of the 
animation once it has completed playback. The Pin makes it quite easy to animate "backwards".

1 Create a new Edge Animate project and save it onto the local disk.

2 Adjust the Stage as follows by using the Properties panel:

•  Stage W: 940 px

• Stage H: 198 px

• Background Color:#000000

• Overflow: hidden

3 Go to the application menu and select File | Import… to bring up a file browser.

4 Select all of the .png files located within the provided assets folder and click on Open. The selected files will be 
placed upon the Stage and also added to the project Library.

5 The background image is the exact size of the Stage itself and should fill this entire area.

6 The album art can be arranged evenly across the bottom of the Stage as seen in the following screenshot. We can use 
the mouse or the Properties panel to arrange these images. Space them evenly apart from one another.

7 Finally, we need to add a title to this header animation. We'll use the Text tool to form the project's name along the 
top of the header. Choose Text tool (T) now.

8 Add a new text element to the Stage and type the term An Early Morning Letter, Displaced into the field.

9 With this text element selected, enter the Properties panel and make the following adjustments:

• ID: Title
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• Location X: 16 px

• Location Y: 11 px

• Font Name: Arial Black, Gadget, sans-serif

• Font Size: 40 px

• Font Color: #bbbbbb

10 We should now have a composition that appears as shown in the following screenshot:

Performing the animation of elements
We will now perform the animation of all elements on the Stage through use of the Playhead, Mark, and Properties 
panel.

Animating the background
We will create a transition lasting 00:07.000, which will fade in the background element while slightly adjusting its 
scale.

1 Using the Selection tool, click on the bg element to bring up its properties.

2 In the Timeline, move the Pin to 00:07.000 and the Playhead to 00:00.000.

3 Using the Properties panel, make the following adjustments:

• Scale (linked): 115 %

• Opacity: 25 %

4 In the Timeline, click on the transition that we have just created to select it.

5 In the Timeline, change the Easing selection to Ease Out | Sine to determine how the transition should occur upon 
playback. Leave the scale transitions as Linear.

Animating the cover art (do this for each cover art image)
For each image, we will create a transition lasting 00:02.000, which with slide the image in from off-screen, resulting in 
a playful bounce before coming to a rest. We will stagger the transitions of each subsequent image to begin at the 
midpoint of the previous transition, creating a flurry of motion within the composition.

1 Using the Selection tool, click on the fvm001 element to bring up its properties.

2 In the Timeline, move the Pin to 00:02.090 and the Playhead to 00:00.000.
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3 Using the Properties panel, make the following adjustment:

• Location X: 986 px

4 In the Timeline, click on the opacity transition that we have just created to select it.

5 In the Timeline, change the Easing selection to Ease Out | Bounce to determine how the transition should occur 
upon playback.

6 Repeat the previous steps for each of the other album art images.

Note: Edge Animate also includes the option to paste various elements of a transition from one object to another. For 
repeatable transitions such as this one, we may want to have a look at the Paste Special commands under the application 
Edit menu.

Animating the title text
We will create a transition lasting 00:05.500, which will fade in the title text element.

1 Using the Selection tool, click on the Title element to bring up its properties.

2 In the Timeline, move the Pin to 00:06.000 and the Playhead to 00:05.000.

3 Using the Properties panel, make the following adjustment:

• Opacity: 0 %

4 In the Timeline, click on the transition that we have just created to select it.

5 In the Timeline, change the Easing selection to Ease In | Cubic to determine how the transition should occur upon 
playback.

Finishing up!
Once all of the elements are added to the Stage, positioned correctly, and animated properly through transitions, the 
Edge Animate Timeline will look similar to what we see in the following screenshot:

Note: Edge Animate makes it easy to see exactly what is going on in a composition through even fine-grained transition 
indicators, which correspond to individual element properties.

The result of our animated banner appears in a web browser, as shown in the following screenshot. To publish an Edge 
Animate composition to the browser, we can choose File | Preview in Browser from the application menu.
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Summary
In this chapter, we've examined how to create motion in Adobe Edge Animate by making use of the Timeline, Playhead, 
Pin, and Properties panel. Those who are familiar with Flash Professional or After Effects should recognize just how 
familiar many of these concepts are, and possibly how refined and evolved these concepts have become as implemented 
in the Edge Animate application interface. It is quite easy to both create and edit animation within an Edge Animate 
composition!

Adding basic interactivity
Lesson overview

In this lesson, you’ll learn how to do the following:

• Understand interactivity

• Work with the syntax of JavaScript

• Recognize the relationship between JavaScript, jQuery, and the Edge Animate API

• Differentiate triggers, events, and actions

• Add triggers to the Timeline

• Insert labels

• Create actions to respond to events

• Control the behavior of the Timeline playhead

• View and edit script with the Code panel

• Use comments to annotate code

• Hide and show elements to incorporate visual feedback for buttons

• Control animated elements

• Customize the mouse cursor

This lesson will take approximately two hours to complete. Before you begin, download the Lesson05 content.

http://ptgmedia.pearsoncmg.com/imprint_downloads/peachpit/peachpit/downloads/AdobeEdgeAnimateLesson05.zip
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Let your viewers explore your composition and become active participants. Use Adobe Edge Animate’s built-in code snippets and intuitive panels 
to add actions to create engaging, user-driven, interactive experiences.

Getting started
To begin, view the travel guide that you’ll create as you learn to make interactive projects in Adobe Edge Animate.

1 Double-click the 05End.html file in the Lesson05/05End folder to play the composition in a browser.
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The project is an interactive photo gallery showing images from Burma. Viewers can watch the short slideshow 
automatically play and loop back to the beginning. Or, viewers can click any thumbnail image on the left side of the 
Stage to go directly to a particular image. Move your mouse over the triangular button at the top to see a caption 
unravel.

In this lesson, you’ll create interactive buttons with rollover highlights and learn to incorporate the proper code that 
tells Edge Animate where to move the playhead on the Timeline to display the particular animation or image there.

2  Close the 05End.html file and quit your browser. 

3 Double-click the 05Start Edge Animate file in the Lesson05/05Start folder to open the initial project file in Edge 
Animate. 
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The file includes all the assets already placed on the Stage and the transitions between each image on the Timeline. 
The Stage has already been sized properly. In this lesson, you'll make this linear animation interactive.

4 Choose File > Save As. Name the file 05_workingcopy and save it in the 05Start folder. Saving a working copy 
ensures that the original start file will be available if you want to start over.

 About interactive compositions
Interactive compositions change based on the viewer’s actions. For example, when the viewer clicks a button, a different 
graphic with more information could appear. Interactivity can be simple, such as the click of a button, or it can be more 
complex, involving different kinds of interactions with the same element—for example, moving your mouse cursor 
over a button, clicking the button, and moving your mouse cursor off the button are three unique events that could each 
result in different visual changes on the Stage.

In Edge Animate, you use JavaScript to achieve interactivity. JavaScript is a popular and standard script for Web 
browsers. JavaScript runs on browsers for desktops as well as on devices such as tablets and mobile phones.

If you have no idea what JavaScript is, or how to write code—don't panic! Adobe Edge Animate provides an easy 
interface to add JavaScript to your compositions and integrate common interactive functions. When you get more 
comfortable with the syntax of the script, you can begin to delve deeper and customize the interactivity.
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In this lesson, you’ll learn to create nonlinear navigation, meaning the animation doesn’t have to play straight from the 
beginning to the end, and stop there. You'll add code that gets triggered when the playhead reaches a certain point in 
time.

You’ll also add code that moves the playhead to different parts of the Timeline to display particular elements. You’ll also 
learn to make elements on the Stage respond to different interactions with the mouse cursor.

 Understanding JavaScript
JavaScript is the scripting language that adds additional functionality to a web page. Many of the common interface 
elements on websites, such as pull-down menus, checkboxes, or search boxes, are created with JavaScript. Edge 
Animate also uses JavaScript to power its interactivity, as well as the animations and other effects.

 Where the JavaScript lives 
Even without adding any interactivity to your composition, your project depends on JavaScript. The JavaScript code is 
contained in several separate text documents that have the file extension “.js”. Look at the files associated with your Edge 
Animate composition, 05_workingcopy. There are four JavaScript files within the folder called edge_includes:

• edge.0.1.6.min.js

• jquery-1.7.1.min.js

• jquery.easing.1.3.js

• json2_min.js

These files contain the basic code required for any Edge Animate composition. There are also additional JavaScript files, 
which are unique to your project. Those files are located outside the edge_includes folder, and are automatically named 
with your Edge Animate filename. Your files are named as follows:

• 05_workingcopy_edge.js

• 05_workingcopy_edgeActions.js

• 05_workingcopy_edgePreload.js

When your Web browser first launches your Edge Animate project, it loads the JavaScript code so all the functionality 
is available when your project plays. All the code is organized as functions, which group commands together. Since each 
function has a unique name, you can trigger the commands simply by referencing the name of the function. 
Programmers say that a function is “called,” or that the browser “calls” a function.

 jQuery and the Edge Animate API
While JavaScript is useful, it’s meant to control all the details of a web page, which is powerful but often clumsy and 
complicated. That’s where jQuery and the Edge Animate API come in handy. jQuery is an open-source JavaScript 
library that provides an easy way to select, control, and animate elements in a browser. jQuery is not another language, 
but simply a set of well-written JavaScript functions. If you look again at the JavaScript files in the edge_includes folder, 
you'll see that two of those files are, in fact, files for jQuery.

Along with jQuery, Edge Animate provides additional functions it has built for you. The library of JavaScript functions 
that Edge Animate has built for your use constitute the Edge Animate API (Application Programming Interface).
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You can think of JavaScript, jQuery, and the Edge Animate API as different layers of control. The Edge Animate API is 
the top, most superficial layer of control, jQuery is the middle, and the core JavaScript is the deepest layer. A useful 
analogy is the control of an automobile. The Edge Animate API would represent the controls you see in the driver’s 
seat—the steering wheel, the parking brake, or the gas pedal. They allow you to drive the car without you needing to 
know much about its inner workings. They’re created from a combination of levers, dials, and shafts to make 
controlling your vehicle simple and easy. Those levers, dials, and shafts represent the jQuery level of control. At the 
most granular level, you have JavaScript, represented by the individual nuts and bolts and gears.

Just as it is so much easier to drive a car using the steering wheel and gas pedal, so it is to control your Edge Animate 
composition with the Edge Animate API. But in both cases, there’s no reason why you couldn’t tinker with the deeper-
level controls for a more customized experience. You can start coding in jQuery and JavaScript to make your own 
interactivity. You just need to be sure you’re a competent mechanic, or know your way around JavaScript!

In this lesson, you’ll first learn to add interactivity with the Edge Animate API. Later, as you gain more confidence and 
comfort, you’ll delve a little deeper and insert some jQuery for more sophisticated effects.

 Triggers, events, and actions
Edge Animate uses actions, triggers, and events to incorporate JavaScript in your composition.

Actions are the things that Edge Animate can do, which, given the full JavaScript language at its disposal, is quite a lot. 
Actions can range from loading a hyperlink, to changing a particular visual property of an element on the Stage, to 
storing a piece of information in a variable for later retrieval.

Triggers are actions that are placed along the Timeline. When the playhead reaches the trigger, the actions are executed. 
Use triggers when you want code to be synchronized by your animation, and not by user control.

Events are things that happen in a composition that Edge Animate can respond to with an action. Typically, events are 
user-generated, such as the click of a mouse button, the pressing down of a key, or the tilting of a mobile device. 
However, events can also happen automatically. For example, the point when the composition is ready (when all the 
assets and code libraries have been downloaded) is an event. Events are always paired with actions. When an event 
happens, an action—or set of actions—is executed.

 Timeline triggers
Triggers are the simplest way to add code to your Edge Animate composition. Triggers are executed automatically when 
the playhead reaches them on the Timeline. You can have multiple triggers along the Timeline. The minimum time 
interval between triggers is 1/1000th of a second, but practically, you’d never need or want actions to be executed so 
close together.

 Creating a loop
For this slideshow of Burma, you’ll insert a trigger at the end of the Timeline to make the playhead automatically return 
to the beginning, creating a loop.

1 Click the Zoom Timeline to Fit button at the bottom of the Timeline.

The entire slideshow animation appears in the available space in the Timeline panel.

2 Move the playhead to the very end of the slideshow, at 0:10 seconds.
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3 In the Timeline panel, click the Insert Trigger button on the top Actions row. You can also choose Timeline > Insert 
Trigger or press Ctrl+T (Windows) or Command+T (Mac OS).

An icon that appears as a diamond enclosed by curly braces appears on the Timeline at 0:10 seconds. The icon 
represents a trigger.

A panel appears with a large white text-entry field and a column of code snippet options on the right side. The panel 
is titled Trigger@10000ms, referring to the trigger's position at 10,000 milliseconds, or 10 seconds.

4 Select the content of the current script.

The current script, //insert code here, is known as a comment. Comments always begin with two backslash 
characters, and are descriptions of the code. Comments are non-functional, and don't significantly add to the file 
size of your composition.

5 From the menu of code snippets on the right-hand side of the panel, select the Play from option.
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New code appears in the panel, replacing the existing comment. The new code comes with its own comments that 
describe its function. The code, sym.play(1000);, moves the playhead to a particular point in time on the Timeline 
and begins playing.

6 Replace the 1000 within the parentheses in the code with 0.

The number in between the parentheses of the play() command represents the time to which the playhead will 
move. Since you want the playhead to move to the beginning of the Timeline at 0:00 seconds, enter 0 in the 
parentheses of the play() command.

7 Close the panel and preview your project in a browser by pressing Ctrl+Enter (Windows) or Command+Return 
(Mac OS).

The slideshow plays through and repeats when it reaches the end at 10 seconds.

Note: The number in between the parentheses of the play() command is called the argument. It gives the command 
additional information to make it more specific. In this case, it tells the command at what millisecond point in time to 
start playing. Commands can have multiple arguments, which are separated by commas. As you learn more commands, 
you also learn what arguments they require.

 Editing triggers
Editing the script for your triggers is simple and easy. The panel that appeared when you added the trigger is always 
available for modifications, additions, or deletions.

• To edit a trigger, double-click the trigger icon on the Timeline.

• The script panel opens to display the trigger, and you can modify the argument, delete the code, or add new code 
from the snippet options on the right side of the panel.

• To move a trigger, click and drag the trigger icon on the Timeline to a new position.

• The trigger moves to a different position, so the actions are executed when the playhead reaches a new time.

• To delete a trigger, select the trigger on the Timeline and press the Delete key.

The trigger is removed from the Timeline.
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Script panel viewing options: The script panel that opens when you add a trigger has several options to help you make 
viewing the code easier. The top-right options menu has three choices that control what’s displayed.

• Show Line Numbers displays sequential numbers next to each line of code so you and other developers that share 
the script can pinpoint code.

• Font Size controls the display size (Small, Medium, or Large) of the text in the script. The default option is Small.

• Include Snippet Comments automatically adds comments to the code that you add from the snippet options on 
the right side of the panel.

In addition to these display options, you can click the vertical border that divides the white script area with the menu of 
code snippets to collapse the menu to make more room for your code. Click the divider again to expand the menu.

 Minding your syntax
Let’s examine the code that you added in the trigger more closely to learn about JavaScript syntax, or the way words and 
punctuation work together. Syntax is the grammar of a programming language.

If you’re unfamiliar with program code or scripting, the JavaScript code that Edge Animate inserts may be challenging 
to decipher. However, once you understand the basic syntax, you’ll find it easier to follow a script.

The code that is in your trigger at 10000 milliseconds appears as follows:

sym.play(0);

• The first word in the statement is sym. When the statement is on the main Timeline, the word sym represents the 
whole Edge Animate composition. Edge Animate is organized around the concept of “symbols,” and the root, or 
base-level symbol is the Edge Animate Stage. This root symbol contains all the elements and animations in your 
Edge Animate composition—everything on the Stage or Timeline. In JavaScript, when we want to do something, 
you first identify the object that you want to control. In this case, since you want to affect the Timeline of your Edge 
Animate composition, the first thing that is written in the script is sym.

• The dot operator (.) provides a way to access different commands for the object that you’ve identified (in this case, 
sym). Objects can be animations, text, or abstract concepts such as the date or particular data. Objects have 
properties, which describe them, and methods, which are the things that they can do. In your trigger, the method 
for the sym object is play(). The dot, or period separates the object and its method.

• As in English, every open parenthesis must have a corresponding close parenthesis, and the same is true for 
JavaScript. If you open something, you must close it. All methods have parentheses. Your method, play(), has an 
open and close parenthesis.

• Each method can have different arguments in between the parentheses, which provide additional information. The 
play() method requires a single argument, which tells Edge Animate at what point in time (in milliseconds) to begin 
playing. Methods can have multiple arguments, which are separated by commas.

• Some arguments require a number, some may need a name, and others may need the words true or false. Whenever 
you’re entering the name of a file or a URL, use single or double quotation marks. Quotation marks distinguish a 
String value, which represent a sequence of characters, with other kinds of values.
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• You can add comments to remind you or others of what you are accomplishing with different parts of the script. To 
add a comment for a single line, start it with two slashes (//). To type a multiline comment, start it with /* and end 
it with */. Comments are ignored by JavaScript and won’t affect your code at all.

• Thesemicolon at the end of the line tells JavaScript that it has reached the end of a complete statement and the end 
of a line of code. A semicolon is like a period in a sentence.

That’s a lot of information packed into a single line of code! But getting comfortable with the syntax is your first step in 
getting out from behind the steering wheel and looking under the hood of your car.

 Events and actions
So far, you’ve seen how Edge Animate uses triggers to automatically execute JavaScript when the playhead reaches a 
certain point on the Timeline. You added a trigger at the end of the animation to create a loop. The other two ways with 
which Edge Animate adds JavaScript is with events and actions.

Events are occurrences that happen in Edge Animate that it can detect and respond to. When an event is detected, you 
provide actions as a response.

It’s useful to think of interactions in terms of events and actions. When you click on a menu button (event), more 
options may expand (actions). When you roll over a button (event), a triangular play icon may appear on it (actions). 
In the next section, you’ll add thumbnail images to the Stage. When the user clicks on each thumbnail (event), the 
playhead will move to a new position on the Timeline (actions) to show a particular image from the travel slideshow.

Creating the buttons
A button is a basic visual indicator of what the user can interact with. The user usually clicks a button, but many other 
types of interactions are possible. For example, rollovers, double-clicks, and rollouts are all possible. Edge Animate also 
provides events unique to mobile devices, such as touches.

You’ll start with the simplest, and most common event, which is the single-click. 

Adding the thumbnails
Small, cropped versions of the larger Burma images are provided for you in the images folder.

1 In the Library panel, expand the images folder within the Assets folder.

2 Drag the file called button1_gray.jpg from the Library panel to the Stage.

A grayscale thumbnail of fisherman appears on the Stage, Timeline, and Elements panel.

3 Position the thumbnail so that its top-left corner is at the top-left corner of the Stage. The coordinates should be at 
X=0, Y=0.
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4 Drag the file called button2_gray.jpg from the Library panel to the Stage, and position it just below the first 
thumbnail. You can use the smart guides to help automatically snap the images in place. The coordinates should be 
at X=0, Y=80.

Two grayscale thumbnails are at the left side of the Stage, one above the other

5 Drag the remaining three grayscale thumbnails from the Library panel onto the Stage, positioning each successive 
one below the previous one.

There should be a total of five thumbnail images vertically stacked on the left side of the Stage.
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 Adding the events
Each element on the Stage can have its own events and actions. Insert code for individual elements from the far left 
column of the Timeline or Elements panel. The Open Actions button is indicated by a set of curly brackets.

1 In the Timeline or the Elements panel, click the Open Actions button for the first thumbnail element, button1_gray.

The script panel for button1_gray opens.

A menu of options automatically opens, displaying the events that are possible for the button1_gray element.
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2 Select the first option: click.

Edge Animate adds a click tab at the top of the panel with an empty script pane and available snippets on the right.

Note: As you add more events to the same element, additional tabs appear at the top of the script panel.

Note: To delete an event (and any code associated with it), select the particular tab for the event and click the Minus 
button at the top-left corner of the script panel.

 Adding the actions
Each event must have an accompanying action, or a response, to the event.

1 Position your cursor on the second line of the script pane (after the first line of comments), and choose the Stop at 
option.
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Edge Animate adds the code to stop the playhead at a particular position on the Timeline.

2 In between the parentheses of the stop() method, replace the 1000 number with 0.

The stop() method requires a number, in milliseconds, of the point on the Timeline at which it will move to and stop. 
Since this first grayscale thumbnail is of the fishermen, you want the playhead to stop at 0:00 seconds, the point at 
which we see the full image of the fishermen on the Stage.

Note: You can actually use any number between 0 and 1500 for the stop() method for button1_gray, since the image of 
the fisherman remains on the Timeline until 1.5 seconds, but it’s simpler and easier to be consistent to pick the time when 
the image first appears.

3 Close the script panel.

The Open Actions icon for the button1_gray element becomes filled in, indicating that there is currently script 
attached to that element.



109
Use motion paths

Last updated 6/15/2014

4 Preview your Edge Animate composition in a browser by selecting File > Preview in browser, or pressing Ctrl+Enter 
(Windows)/Command+Return (Mac OS).

5 At any point during the slideshow, click the first grayscale thumbnail.

The slideshow stops and shows the image of the fishermen.

 Completing the interactivity
Now that you’ve completed the interactivity for the first button, add the same functionality to the remainder.

1 In the Timeline or the Elements panel, click the Open Actions button for the second thumbnail element, 
button2_gray.

The script panel for button2_gray opens. 

2 Click on the Plus button on the upper-left corner.

A menu of options opens, displaying the events that are possible for the button2_gray element.

3 Select the first option: click.

Edge Animate adds a click tab at the top of the panel with an empty script pane and available snippets on the right.

4 Position your cursor on the second line of the script pane (after the first line of comments), and choose the Stop at 
option.

Edge Animate adds the JavaScript code to stop the playhead at a particular position on the Timeline.

5 In between the parentheses of the stop() method, replace the 1000 number with 2000.

The stop() method requires a number, in milliseconds, of the point on the Timeline at which it will move to and stop. 
Since the second grayscale thumbnail is of the statues, you want the playhead to stop at 0:02 seconds, the point at 
which we see the full image of the statues on the Stage.
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6 Add similar click events to all the other grayscale thumbnail images, with the Stop at option. Be sure to change the 
arguments for each stop() method as follows, so the playhead stops at different times to display a unique larger 
image on the Stage:

• The stop() method for button1_gray should go to 0 milliseconds.

• The stop() method for button2_gray should go to 2000 milliseconds.

• The stop() method for button3_gray should go to 4000 milliseconds.

• The stop() method for button4_gray should go to 6000 milliseconds.

• The stop() method for button5_gray should go to 8000 milliseconds.

 Navigating the Code panel
Your travel slideshow is now interactive, where users can click to see any of the images. But your code appears to be 
scattered among many different elements. How can you view all the code for your Edge Animate composition together? 
The answer is in the Code panel, which you can open by choosing Window > Code, or pressing Ctrl+E (Windows) or 
Command+E (Mac OS).

 Viewing your code
The Code panel displays all the code in your Edge Animate composition—both the code that is automatically generated 
for every project, and the code that you insert yourself.

1 Choose Window > Code, or press Ctrl+E (Windows)/Command+E (Mac OS).

The Code panel opens. The Code panel is similar to the other script panels for triggers, events, and actions.

2 Click on the Full Code button on the far right side of the panel to toggle between Full Code mode and non-Full Code 
mode.

In Full Code mode, Edge Animate displays the entire code for the JavaScript file for the Edge Animate composition. 
Scroll down to see the script for all your thumbnail elements as well as the trigger. The code that this represents is 
contained in the file 05_workingcopy_edgeActions.js.
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In non-Full Code mode, you can select the code for the individual elements or triggers on the Stage on the left side 
of the panel. In addition, there is an option to see the code for the Preloader, which is currently disabled because you 
haven’t yet added one. In later lessons, you’ll learn about adding a Preloader.

3 While in non-Full Code mode, click on the Plus button in line with the Stage element.

A hierarchical menu appears that allows you to add an event to the Stage itself, an event to any of the elements on 
the Stage, or an event to the Timeline.



112
Use motion paths

Last updated 6/15/2014

4 If you want to delete an event or trigger from the Code panel, right-click on the event or trigger from the list and 
select Delete Action.

5 In either Full Code or non-Full Code mode, when you make additions and edits to the script, and they are saved in 
the composition.

Dealing with code errorsUsing the provided code snippets makes adding code relatively easy because the script is 
already formatted correctly. All you have to do is replace key values. However, bugs and typos do invariably creep 

in, and dealing with code errors is a common struggle for any developer, whether a novice or an expert.Edge Animate 
immediately alerts you to code errors, which make finding and correcting them easy. When there is a mistake in syntax 
in any of the code, Edge Animate displays an error message at the bottom left corner of the Code panel. For example, if 
you were to accidentally delete the closing parenthesis of the stop() method, the error display tells you where the error 
occurs. In addition, a red dot appears next to the line of code in question.The error notification is also displayed at the 
bottom-right corner of the Stage.
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Click on the arrow icon after the error description to jump directly to the source of the error in the Code panel so you 
can fix it. The All or Code options in the error display determines whether all errors are displayed (including 

warnings of feature incompatibilities with various devices, such as text shadows in IE9), or only code errors are 
displayed.

 Creating labels
When the user clicks each thumbnail, Edge Animate moves the playhead to a new time on the Timeline, according to 
the argument in the stop() method. However, imagine that the client who has commissioned you to develop this 
slideshow wants the whole sequence to run a little slower. That’s an easy task to do because you can select all of the 
elements on the Timeline and move all the keyframes and animations forward to lengthen the total amount of time. But 
doing so causes the times that each image appears on the Stage to change, which would require you to change all the 
millisecond values in the stop() methods.

There is an alternate approach that would save you time and effort. Instead of using fixed-millisecond times in the 
stop() methods, you can use labels, which refer to points on the Timeline. Labels can move with your animation, so 
increasing or decreasing the length of your animation can move the labels proportionately.

 Adding labels
Labels appear on the Timeline panel, below the time markers and just above the Actions layer.

1 Move the playhead to 0:00 seconds. 
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The image of the fisherman appears at 0:00 seconds.

2 Click the Insert Label button, or press Ctrl+L (Windows)/Command+L (Mac OS).

A label appears on the Timeline, named Label 1.

3 Rename the label fishermen, and press Enter to exit the text editing of the label.

The label called fisherman is now associated with 0:00 seconds.

4 Add four more labels to the Timeline, each marking the starting point at which an image appears on the Stage.

• Insert the label statues at 0:02 seconds.

• Insert the label houses at 0:04 seconds.

• Insert the label monk at 0:06seconds.

• Insert the label women at 0:08 seconds.

 Editing labels
There are several ways you can edit labels once you’ve inserted and named them:

• To rename a label, double-click the label name on the Timeline.

• To move a label, click and drag the label on the Timeline to a new position.

• To delete a label, select the label on the Timeline so it is highlighted and press the Delete key.

• To cut, copy or paste a label, right-click on a label and choose your desired option, or use the standard keyboard 
commands for cut (Ctrl/Command+X), copy (Ctrl/Command+C), and paste (Ctrl/Command+V).
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 Changing the references to the Timeline
Now that the Timeline contains labels, you can change the references in the JavaScript code.

1 Choose Window > Code, or press Ctrl+E (Windows)/Command+E (Mac OS).

The Code panel opens.

2 If it is not already selected, click the Full Code button to display the panel in Full Code mode.

All the code for the thumbnail events and actions are displayed in the single script pane.

3 Replace all the millisecond times in the stop() methods with your labels. The following lines of code should be 
changed:

• Change sym.stop(0); to sym.stop("fishermen");

• Change sym.stop(1500); to sym.stop("statues");

• Change sym.stop(3500); to sym.stop("houses");

• Change sym.stop(5500); to sym.stop("monk");

• Change sym.stop(7500); to sym.stop("women");

Note: Make sure that you are using straight quotation marks around your label names. The quotation marks are 
essential for JavaScript to identify the names as a String (and not a variable). Straight quotes and curly quotes (or smart 
quotes) are different characters in HTML and JavaScript and they are not interchangeable.

4 Preview your Edge Animate composition in a browser by choosing File > Preview in the browser, or pressing 
Ctrl+Enter (Windows)/Command+Return (Mac OS).
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5 At any point during the slideshow, click the thumbnail images.

The slideshow stops and shows the selected image.

6 Return to Edge Animate and select all the elements on the Timeline by choosing Select > All, or by pressing Ctrl+A 
(Windows)/Command+A (Mac OS). Make sure none of the elements are locked.

7 Click and drag the last keyframe of the last animated element on the Timeline. Drag the keyframe to the left to 
decrease the total amount of time of the slideshow.

As you decrease the length of time for all the animated elements, the labels also move proportionally, preserving 
their identification of what's displayed on the Stage. Return the total time of the composition to 0:10 seconds.

 Adding visual feedback
Most interactive elements on the Web feature visual feedback, which is important to provide clues to the reader that the 
particular item is interactive. For example, a simple hyperlink on a web page often will change color when you move 
your mouse over it. A button will highlight when you move your mouse over it, and may appear depressed when you 
click on it.

You can create these interactions with a combination of events and actions in Edge Animate. You’ll add these events 
and actions to the thumbnails for visual feedback next.

 Adding the mouseover thumbnails
The first question you should ask is, what visual effect do you want to see when a user moves their mouse over the 
thumbnail images? For this project, you’ll make the grayscale thumbnails become colorized, and a highlight appear 
around the borders. The first step is to bring colorized versions of the thumbnails on to the Stage. 

1 In the images folder in the Assets folder of the Library panel, you’ll find color versions of each of the five thumbnail 
images, indicated by the _color appended to the file name.

2 Drag button1_color.jpg from the Library on to the Stage.

3 Use the Smart Guides to position the button1_color element at the upper-left corner, exactly on top of its grayscale 
version. Its location should be at X=0, Y=0.
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4 Drag all four of the other colorized versions of the thumbnails to the Stage, positioning them exactly on top of their 
grayscale partners. All the colored thumbnails should be at the top of the Element panel stack.

The grayscale and colorized versions of the thumbnails are exactly the same dimensions.

 Hiding the mouseover thumbnails
Since you want to show the colorized version only when the mouse cursor moves over the thumbnail, you must first 
hide the colorized thumbnails. You can hide the elements by changing their Display property to Off.

1 Move the playhead to 0:00 seconds.

2 Hold down the Shift key and select all the colorized thumbnail elements.

3 In the Properties panel, change the Display property from On to Off.

Edge Animate inserts a new keyframe on the Timeline for all the selected elements at 0:00 seconds and the selected 
elements disappear from the Stage.
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 Inserting the mouseover event
Each grayscale thumbnail contains a click event. You’ll have to edit each of those elements to incorporate a mouseover 
event. A mouseover event happens when the user moves their mouse cursor over the selected element. When the 
mouseover event happens, you'll show the colorized thumbnails.

1 In the Timeline or the Elements panel, click the Open Actions button for the first thumbnail element, button1_gray.

The script panel for button1_gray opens. The current click event and actions appear.

2 Click on the Plus button on the upper left corner and choose mouseover.

Edge Animate adds a mouseover tab.



119
Use motion paths

Last updated 6/15/2014

3 Position your cursor on the second line of the script pane (after the first line of comments), and choose the Show 
Element option.

Edge Animate adds the JavaScript code to display an element. The highlighted portion of the code is the name of 
the element to display.

4 Replace the highlighted code with button1_color. Make sure that the double straight quotation marks remain 
around your element name.

The full statement appears as follows:

sym.$("button1_color").show();

The dollar sign and parentheses is jQuery syntax, and it tells the browser what element to select. In this statement, 
the element called button1_color in the current Edge Animate composition is selected, and the method called 
show() is executed.
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5 Preview your Edge Animate composition in a browser by choosing File > Preview in your browser, or pressing 
Ctrl+Enter (Windows)/Command+Return (Mac OS). Move your mouse over the first grayscale thumbnail image.

As soon as your mouse cursor moves over the grayscale thumbnail image, the colorized version appears. Since the 
colorized version is above the grayscale version, we see only the colorized image.

6 Return to Edge Animate and insert the mouseover event with the Show Element action to the remaining four 
grayscale thumbnail buttons. Make sure to replace the highlighted code portion with the correct colorized version 
of the thumbnail.

 Inserting the mouseout event
When you preview the Edge Animate project, you’ll notice that the thumbnails become colorized when you move your 
mouse over them, but they remain in color even after you move your mouse off of them. In order to make the 
thumbnails revert to their grayscale versions, you need to add one additional event: the mouseout event.

The mouseout event happens when the cursor moves off of an element. You’ll add the mouseout event to the colorized 
thumbnails (not the grayscale thumbnails) and pair the event with a command that hides the colorized versions. The 
result: The colorized versions disappear leaving the grayscale version visible again.

1 In the Timeline or the Elements panel, click the Open Actions button for the thumbnail element button1_color. The 
element is currently hidden on the Stage, but you can still add script to it.
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The script panel for button1_color opens.

2 In the popup menu that appears, choose mouseout for the event.

Edge Animate adds a mouseout tab.

3 Position your cursor on the second line of the script pane (after the first line of comments), and choose the Hide 
Element option.

Edge Animate adds the JavaScript code to display an element. The highlighted portion of the code is the name of 
the element to display.
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4 Replace the highlighted code with button1_color. Make sure that the double straight quotation marks remain 
around your element name.

The full statement appears as follows:

sym.$("button1_color").hide();

Note the similarities between the actions for this mouseout event and the previous script for the mouseover event.

5 Preview your Edge Animate composition in a browser by choosing File > Preview in your browser, or pressing 
Ctrl+Enter (Windows)/Command+Return (Mac OS). Move your mouse over the first grayscale thumbnail image.

As soon as your mouse cursor moves over the grayscale thumbnail image, it becomes colorized. When you move 
your mouse cursor off of the image, the button appears to revert back to grayscale.

6 Return to Edge Animate and insert the mouseout event with the Hide Element action to the remaining four 
colorized thumbnail buttons. Make sure to replace the highlighted code portion with the correct colorized version 
of the thumbnail.

 Editing the click event
One final fix is needed before all the events and actions work together. You may have noticed that clicking on the 
buttons don’t move the playhead as you intend. The reason it no longer works is because the colorized thumbnails 
overlap their grayscale counterparts, which block the click events. Your final step is to remove the click event from the 
grayscale thumbnails and add them to the colorized thumbnails instead.

1 In the Timeline or the Elements panel, click the Open Actions button for each of the grayscale thumbnail elements.

2 Choose the click event tab on the script panel, and click the Minus button.

Edge Animate deletes the click event and all of its actions.

3 In the Timeline or the Elements panel, click the Open Actions button for each of the colorized thumbnail elements.

4 Click on the Plus button on the upper-left corner and choose click for the event.

Edge Animate adds a click event tab.

5 Choose the Stop at option, and as you did before, replace the millisecond argument with the corresponding label on 
the Timeline.
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6 Preview your Edge Animate composition in a browser by choosing File > Preview in your browser, or pressing 
Ctrl+Enter (Windows)/Command+Return (Mac OS).

Your buttons are complete. When you move your mouse over them, they become colorized. When you move your 
mouse off of them, they revert to grayscale, and when you click on them, Edge Animate displays the corresponding 
image from the slideshow.

Using the Code panel to make global edits: Making global edits as you did in this task, such as deleting all the click 
events from a set of elements, can be arduous because of the need to select and modify each element. However, using 

the Code panel can be a huge time-saver if you’re careful about selecting and editing code.Open the Code panel by 
choosing Window > Code, or pressing Ctrl+E (Windows)/Command+E (Mac OS), and choose the Full Code mode. 
Examine the code for all the click events (which are referred to as "click") for all the desired elements. Delete everything 
that begins with the statements that include the click event and ends with //Edge binding end.

Events for the mouse and for touch devices: The following list explains the available events that you can attach to 
your elements for interaction with the mouse or with a touch. For most users, the click event or touchstart event will 

be sufficient for all projects.

• click, an event that happens when the mouse button is pressed and released.

• dblclick, an event that happens when the mouse button is pressed and released twice in rapid succession.

• mouseover, an event that happens when the mouse cursor moves over an element.

• mousedown, an event that happens when the mouse button is pressed.

• mousemove, and event that happens whenever the mouse cursor moves within an element.

• mouseup, an event that happens when the mouse button is released.

• mouseout, an event that happens when the mouse cursor moves off of an element.

• touchstart, an event for touch devices when a user touches an element.

• touchmove, an event for touch devices that happens when the user touches and drags a finger over an element.

• touchend, an event for touch devices that happens when the user stops touching an element.

Other user events such as keyboard presses are also available, but not for individual elements. Key presses are associated 
with the Stage element, and you'll explore those and other kinds of events in the next lesson.

 Customizing the mouse cursor
In addition to the visual feedback that you can provide by changing the appearance of the button when the user 
interacts with it, you can also change the appearance of the cursor itself. Often, the default arrow cursor on a desktop 
or laptop browser changes to a hand (known as the pointer cursor) when it hovers over an interactive element or 
hyperlink. You can choose to change the cursor to a pointer, or choose from among dozens of other cursor types.
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 Using the pointer
The Properties panel controls the cursor appearance and allows you to select a custom icon for each element.

1 In the Timeline panel, temporarily turn the Display property for the five colorized thumbnail elements to On.

Turning on the Display property allows you to select them on the Stage.

2 Select all five colorized thumbnail elements, button1_color through button5_color.

3 In the Properties panel, click the Cursor option and choose the pointer icon.

4 Turn the Display property for the five colorized thumbnail elements back to Off.

The colorized thumbnail elements are hidden again.

5 Preview your Edge Animate composition in a browser by choosing File > Preview in your browser, or pressing 
Ctrl+Enter (Windows)/Command+Return (Mac OS).

The pointer cursor appears whenever you move your mouse over or click on the buttons

Note: You can only change the appearance of the cursor for each element, and not for every event of an element.

 Controlling animated elements
So far, you’ve added JavaScript that controlled the behavior of the playhead and the hiding or displaying of particular 
elements. You can also add code to control the playback of animated symbols.
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Symbols, as you learned in the previous lesson, are independent objects that you create that can have their own internal 
animation. With JavaScript, you can control the symbol animations to create more sophisticated interactions. For 
example, you can create a button that controls a dramatic animated unfurling or closing of a map. Or, you can create a 
button that controls the animated expansion or collapse of a more info box. The map and the more info box would be 
Symbols that behave independently on the main Timeline.

For your interactive travel slideshow, you’ll add a button at the top of the Stage that, when rolled over, elegantly animates 
to reveal information about the images and Burma.

 Adding the button and animated symbol
The button and the animated symbol have already been created for you, and are in the Library ready to use.

1 In the Library panel, expand the Symbols section, and drag the moreinfo symbol to the Stage. Position the moreinfo 
symbol at X=200, Y=0.

The moreinfo symbol appears in the Elements and Timeline panels. The short playback arrowheads on the Timeline 
show how long the animation within the symbol lasts (one second long).

2 In the Timeline, click the Playback options for the moreinfo element and choose Stop.

The playback of the internal symbol animation does not play on the main Timeline.

3 Double-click the moreinfo symbol on the Stage and press the spacebar to view the animation within the symbol.

The symbol consists of two short animations. The long horizontal gray rectangle expands, and at the same time, the 
clipping box of some informational text expands to reveal it.
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4 Click the Stage button at the top of the Stage to exit your symbol.

5 Drag the triangle.png image from the Library Assets folder to the Stage. Position the triangle element at X=484, Y=3, 
or use the Smart Guides to center the element over the moreinfo element.

 Play a symbol animation
The symbol is currently stopped at 0 seconds. You’ll add a mouseover event to the triangle button that tells the symbol 
to begin playing.

1 In the Timeline or the Elements panel, click the Open Actions button for the triangle element.

The script panel for triangle opens.

2 Choose mouseover for the event.

Edge Animate adds a mouseover event tab.
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3 Choose the Get Symbol option.

Edge Animate adds the JavaScript code to select a particular symbol on the Stage. The highlighted portion of the 
code is the name of the symbol that you want to select.

4 Replace the highlighted code with moreinfo, to match the moreinfo element on the Stage. Make sure that the double 
straight quotation marks remain around your element name.

The full statement appears as follows:

var mySymbolObject = sym.getSymbol("moreinfo");

The first part of this statement, var mySymbolObject, creates a variable for the reference to your symbol, so you can 
control it.

5 On the next line in the script panel, choose the Play option.

Edge Animate adds a statement that plays the sym object, or the main Timeline. However, you want the symbol to 
play its animation, not the animation on the main Timeline.

6 Replace sym with the variable, mySymbolObject, which refers to your sym.
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The next statement appears as follows:

mySymbolObject.play();

Note: You can combine the two statements into one line as follows, sym.getSymbol("moreinfo").play();

 Reset the symbol animation
Now, you'll add a mouseout event for the triangle element to move its playhead back to 0 seconds to reset the animation.

1 In the Timeline or the Elements panel, click the Open Actions button for the triangle element.

The script panel for moreinfo button opens.

2 Step textClick on the Plus button on the upper left corner and choose mouseout for the event.

Edge Animate adds a mouseout event tab.

3 Choose the Get Symbol option, and replace the highlighted code with moreinfo.

The full statement appears as follows:

var mySymbolObject = sym.getSymbol("moreinfo");

4 On the next line in the script panel, choose the Stop at option.

Edge Animate adds a statement that stops the sym object, or the main Timeline. However, you want the symbol to 
stop its animation, not the animation on the main Timeline.

5 Replace sym with the variable, mySymbolObject, which refers to your symbol. Replace the 1000 default millisecond 
argument with 0.
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The next statement appears as follows:

mySymbolObject.stop(0);

6 Preview your Edge Animate composition in a browser by choosing File > Preview in your browser, or pressing 
Ctrl+Enter (Windows)/Command+Return (Mac OS).

When you roll over the triangular button at the top of the Stage, the moreinfo symbol plays its animation, which 
reveals the text box and text. When you roll off the button, the text box and text collapse.

Using jQuery Effects
The Edge Animate API offers a nice balance of power, flexibility, and ease-of-use to incorporate interactivity to your 
designs and animations. Inserting script by simply clicking a button in the script panel is (mostly) foolproof. However, 
adding a bit of jQuery to your scripts can often make your job easier. As you learned earlier in this lesson, jQuery is a 
JavaScript library that was written specifically to make selecting elements on a web page and creating animations and 
transitions simple. There are many jQuery methods for animating elements, such as a fade-in, fade-out, or slide-in and 
slide-out. Since Edge Animate is fully compatible with JavaScript and jQuery, you can use these methods wherever you 
see fit. Let’s examine one particular jQuery method, fadeToggle(). The method fadeToggle() animates an element's 
transparency to fade up or fade down, depending on its current state. If the element is transparent, it will become 
opaque. If the element is opaque, it will become transparent.

1 In a new Edge Animate composition, add a small rectangle and an image on the Stage. Name the rectangle 
Rectangle, and the image Image.
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2 In the Timeline or the Elements panel, click the Open Actions button for the Rectangle element.

3 Choose click for the event.

4 Add the following statement for the click event: sym.$("Image").fadeToggle()

5 That's all! Preview your composition in a browser.

When you click on the rectangle, Edge Animate uses jQuery to select the image and executes the fadeToggle() 
method. The image fades in and out with alternate clicks. jQuery does all the work of creating two inverted 
animations without requiring you to manually create any symbols, keyframes, or mechanisms to remember the state 
of the image. jQuery is powerful and makes a good addition to your designer-developer toolkit. You can view the 
05JQuery.an file in the 05End_JQuery folder to see the completed example.

Review
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Review questions
1 What's the difference between actions, triggers, and events, and how are they used to create interactivity in Adobe 

Edge Animate?

2 What's the relationship between the Edge Animate API, jQuery, and JavaScript?

3 How do you create a button?

4 Why would you use a label, and where are they located?

5 What is the Code panel, and how does it differ from the panels for actions and triggers?

6 What does the code sym mean in the Edge Animate API, and how do you use it?

Review answers
1 Actions, triggers, and events are all JavaScript code that you use to create interactivity in Edge Animate. Actions are 

commands that tell Edge Animate to do something, such as hide or display an element, or load a hyperlink. Triggers 
are actions that are placed on the Timeline so they are executed at a specific time. Events are things that happen in 
a composition that Edge Animate can respond to with actions.

2 Edge Animate uses JavaScript to power its animation and interactivity. JavaScript is the standard scripting language 
for Web browsers. jQuery is a library of well-written JavaScript functions that make it easier to select and animate 
elements on a web page. The Edge Animate API provides additional functions (based on JavaScript and jQuery) to 
control elements in your composition.

3 A button is a visual indicator of what the user can interact with. You can create a button by creating an element on 
the Stage, then clicking the Open Actions button in the Timeline or Elements panel to add an event. In the event tab 
that opens, insert actions that you want triggered when the event happens.

4 Labels are located at the top of the Timeline. Labels identify specific points in time so that you can refer to label 
names, rather than fixed milliseconds, in your JavaScript code.

5 The Code panel, which you access by pressing Ctrl+E (Windows)/Command+E (Mac OS), allows you to display all 
the JavaScript code associated with your current Edge Animate composition. It also shows any code errors and their 
location in the script. In contrast, panels for adding triggers, events, and actions show only the code for the 
associated element, or time. 

6 The word sym represents the whole Edge Animate composition, when the statement is on the main Timeline. Edge 
Animate is organized around the concept of "symbols," and the root, or base-level symbol is the Edge Animate Stage. 
This root symbol contains all the elements and animations in your Edge Animate composition—everything on the 
Stage or Timeline. In JavaScript, when you want to do something, you first identify the object that you want to 
control. If you want to affect the Timeline of your Edge Animate composition, the first thing that is written in the 
script is sym.

Using Animate files in InDesign or Muse (Video)
Using Animate files in InDesign or Muse (Video)

Introduction to Edge Animate
Video Tutorial

Introduction to Edge Animate

http://vimeo.com/54509878
http://tv.adobe.com/watch/learn-edge-animate/what-is-edge-animate-and-what-can-i-create-with-it/
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Create your first Edge Animate project
Create your first Edge Animate project

Use Edge Animate file in InDesign or Muse
Use Edge Animate file in InDesign or Muse

Download files from Adobe Dev Center
Download files from Adobe Dev Center

Publishing and integration (Video)
Publishing and integration (Video)

http://helpx.adobe.com/creative-cloud/learn/start/animate.html
http://vimeo.com/54509878
http://www.adobe.com/devnet/edge-animate/articles/showcase-sample-files.html
http://tv.adobe.com/watch/learn-edge-animate/publishing-and-integration/
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Chapter 6: Layout and design

Creating a flexible layout
Creating a flexible layout

Create fluid responsive web page layouts
Create fluid responsive web page layouts

http://www.adobe.com/go/learn_edge_animate_layout_en
http://adobe.ly/12Wa2XQ
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Chapter 7: Integration and publishing

Edge Animate API guide
Edge Animate API guide

Edge Animate and the Twitter API (Video)
Edge Animate and the Twitter API (Video)

Enhance your DPS folios with HTML animations 
(Tutorial)
Enhance your DPS folios with HTML animations (Tutorial)

Spice up your WordPress Site with Edge Animate
Spice up your WordPress Site with Edge Animate

Create a PhoneGap Build app with Edge Animate 
Create a PhoneGap Build app with Edge Animate 

Extending Edge Animate with 3rd party web 
components (Video)
Extending Edge Animate with 3rd party web components (Video)

http://www.adobe.com/go/animate_api_current
http://tv.adobe.com/watch/create-like-crazy-with-adobe-edge/episode-1-edge-and-the-twitter-api/
http://www.adobe.com/go/learn_edge_animate_dps_en
http://adobe.ly/143I6MY
http://adobe.ly/103kMQ6
http://tv.adobe.com/watch/create-like-crazy-with-adobe-edge/episode-3-mix-it-baby-extending-edge-animate/
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